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Chapter 1

Welcome

Wise Solutions’ unique ConflictManager quickly and proactively identifies 

and resolves potential conflicts between Windows-based software 

applications. ConflictManager is a database application that imports 

installation packages and then finds and resolves conflicts caused by files, 

registry keys, and other resources. You use ConflictManager to resolve 

potential conflicts before deploying applications across your organization’s 

workstations, which can reduce post-rollout costs and decrease end user 

downtime.

Conflicts between applications are one of the most time-consuming and 

costly issues in today’s Windows workstation environment. Applications 

that run independently without incident often fail when installed together 

due to file and other conflicts. Conflicts can occur for many reasons, but 

they most commonly occur when two installed applications use a .DLL with 

the same name. For example, Package A installs version 1.0.0.4 of a file 

named report.dll. Package B installs a newer version of the same file, 

version 2.0.0.1. When the two packages are installed on the same 

computer, Package A might have a conflict with the newer version of 

report.dll that is installed by Package B. This conflict could cause a General 

Protection Fault, a hung application, or some other type of problem. This 

type of conflict is commonly called “DLL Hell.”

ConflictManager helps you avoid DLL Hell and other application conflicts. It 

detects conflicts that would be virtually impossible to find efficiently using 

any other method and helps you achieve conflict-free workstations 

throughout your organization.

Major features of ConflictManager include:

• A means to detect and view conflicts between applications.

• Conflict resolution rules that let you resolve conflicts automatically, 

saving time, reducing errors, and providing consistency in conflict 

resolution. With the Enterprise Edition, users can create and modify the 

resolution rules.

• A Resolve wizard that steps you through the process of resolving file 

conflicts.
7



1: WELCOME
• Reports that help you review and analyze conflicts detected by 

ConflictManager.

• The ability to export and recompile resolved installations singly or in a 

batch.

ConflictManager is available as a tool in Wise Package Studio. For more 

information about Wise Package Studio, see the Wise Package Studio Help.

In this section, learn about:

• The documentation that can help you get acquainted with 

ConflictManager quickly.

• How to access online help and context-sensitive help.

• Technical support resources.
8



DOCUMENTATION ROADMAP
Documentation Roadmap

The ConflictManager Reference Manual and online help assume that you 

are proficient in the use of the Windows operating system. If you need help 

using the operating system, consult its user documentation.

ConflictManager often provides multiple ways to accomplish a task. For 

example, to import an application, you can select Import from either the 

Application menu or from the right-click menu. In some cases, you can 

accomplish a task by using the main menu or the right-click menu, or by 

pressing a key combination. Instructions in this documentation generally 

include only the most convenient method of accomplishing a task. If you 

are most comfortable with a particular method, check the right-click menu 

and the main menu to learn the different methods you can use.

The following sources of information are available to help you learn 

ConflictManager.

• Reference Manual. The reference manual is available from the Help 

menu; select Online Reference. It contains detailed technical 

information and step-by-step instructions for performing common tasks. 

It is also available from Wise Solutions as a printed manual for a fee. 

Contact Wise Solutions Sales at 734-456-2100.

• Online Help. All the material in the reference manual is also available 

in the online help system. To access the contents, index, and search 

functions, select Help Topics from the Help menu. To access context-

sensitive help, press the F1 key from any place in the product, and you 

will see help that describes the part of the product that you are in.

• Getting Started Guide. The printed Getting Started Guide contains 

system requirements, installation instructions, and a tutorial. You can 

also access a .PDF copy of the Getting Started Guide from the Help 

menu in Wise Package Studio.

• Release Notes. Product release notes, in .HTM format, are available by 

selecting Release Notes from the Help menu. The release notes 

document covers new features, enhancements, bug fixes, and known 

issues for the current version. It also contains links to release notes for 

other versions of the product.
9



1: WELCOME
Getting Help

Press the F1 key to display a help window for the active window or dialog 

box. You can get help on most windows, dialog boxes, and wizards in 

ConflictManager. Select Help Topics from the Help menu to see all the 

information in the reference manual presented on-screen.

Select other commands from the Help menu to view information on using 

help, to view the .PDF-format reference manual, and to view resources on 

the Web.

If you need help and cannot find the answer in this manual or the online 

help, read about our technical support options in Getting Product Support 

on page 11.
10



GETTING PRODUCT SUPPORT
Getting Product Support

Wise Solutions offers many resources to help you use our products. You 

can search the product help or reference manual .PDF for answers, or you 

can use one of the many support resources available to you as a Wise 

Solutions customer.

Get Support Online
To help you get the most out of our products, we offer world-class 

professional services that include technical support, training, consulting, 

and Web-based resources. Just visit our support page at 

www.wisesolutions.com/support.htm. Our support page contains a 

variety of resources such as a searchable Knowledgebase, Newsgroups, 

and technical support options, as well as a place for you to submit feature 

or enhancement requests.

Check Our Knowledgebase

Access the Knowledgebase by visiting www.wisesolutions.com/

knowbase.asp or by clicking the Knowledgebase link on our Web site’s 

support page. The searchable Knowledgebase contains how-to procedures, 

answers to common support questions, and workarounds. It also contains 

highly technical material on a variety of subjects.

Visit Our Newsgroups

Visit Wise Newsgroups by visiting newsgroups.wisesolutions.com or by 

clicking the Newsgroups link on our Web site’s support page. Newsgroup 

postings by fellow administrators contain answers, tips, analysis, and other 

comments. Contribute your own expertise to help other application 

repackagers.

Subscribe to TechInfo

TechInfo is a free monthly technical newsletter that contains technical tips, 

product updates, and other important technical information. To subscribe 

to TechInfo or to read back issues, visit www.wisesolutions.com/

techinfo.htm or click the TechInfo link on our Web site’s support page.
11
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Ask Our Support Team
If you can’t find an answer in our online resources, Wise Solutions offers 

flexible options to meet your support needs. For additional details about 

our support services, visit our Web site at www.wisesolutions.com/

support or talk with a technical support representative. Before you contact 

technical support, make sure you have the following information:

• Serial number and product version, which you can find by selecting 

About... from the Help menu.

• Operating system version and service pack version if applicable.

• A description of what you do before the problem occurs.

• The exact wording of any error messages you see.

• Your name, company name, and how to contact you.

• Payment information, if applicable.

Standard Support

Standard Support is the perfect solution for registered Wise users who 

have general technical questions about software installations or Wise 

products. You can e-mail or fax unlimited technical questions 24 hours a 

day and receive a response within three business days at no charge. E-mail 

your general support questions to standard@wisesolutions.com or fax 

them to 734-456-2456.

Quick Response Support

Quick Response Support is designed for registered Wise users who need 

quick answers to urgent issues. You can call our technical support 

department directly at 734-456-2600, Monday through Friday, 9:00 a.m. 

to 6:00 p.m. (ET). You will be charged a flat rate per incident for Quick 

Response Support. Talk with a technical support representative about 

purchasing support for multiple incidents at a reduced rate.

Annual Support

Annual Support provides unlimited technical support to registered Wise 

users who have paid an annual subscription fee. Purchasing Annual 

Support entitles you to receive a response to your technical questions 

within one business day. Depending on the Annual Support option you 

choose, you can submit your technical questions in the following ways:

• Call technical support at 734-456-2600, Monday through Friday, 9:00 

a.m. to 6:00 p.m. (ET).

• E-mail the dedicated e-mail address you receive when you purchase 

annual support.

• Fax 734-456-2456.
12



Chapter 2

ConflictManager Basics

ConflictManager is part of Wise Package Studio, and is available as a tool in 

Package Studio’s Workbench. You use ConflictManager to find and resolve 

conflicts between software applications. This section contains an 

introduction to ConflictManager terms and concepts. Additional topics 

cover:

• Starting ConflictManager.

• The ConflictManager interface.

• Using ConflictManager in a multi-user environment.

• ConflictManager Professional and Enterprise Editions.

• The ConflictManager process.

• Types of conflicts.

• Guidelines for resolving file conflicts.
13
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Introduction to ConflictManager

If you are a system administrator or desktop integrator responsible for the 

management and installation of software applications on a large number of 

workstations, ConflictManager can help you do your job more efficiently. 

ConflictManager improves the reliability of end user desktops by reducing 

the risk of problems when you deploy a new application. Using 

ConflictManager, you can detect and resolve potential conflicts before 

adding a new application to those already installed on users’ workstations.

How Do Applications and Packages Differ?
ConflictManager detects and resolves conflicts between Windows-based 

software applications. Applications can include third-party commercial 

software as well as in-house custom software. All applications that are 

installed on computers in your organization should be imported into 

ConflictManager so you can ensure they will not conflict with one another.

When you import an application into ConflictManager, you must assign it a 

package name. Packages represent different versions of a single 

application installation, or different components of a larger suite. For 

instance, the Microsoft Office application installation might contain two 

packages, Office 97 and Office 2000. Another way to organize the Microsoft 

Office application would be to set up packages for Word, Excel, and 

PowerPoint. Because you are not likely to install two versions of an 

application on the same computer, ConflictManager does not look for 

conflicts between packages of the same application. This speeds the 

conflict detection process and avoids showing you conflicts that are not 

relevant.

What Kind of Information Does ConflictManager 
Compare?

During conflict detection, ConflictManager searches the database 

information listed below for each application and marks items that conflict.

File name

Version

Binary version

Size

Date/time

Path

Company

Product

16 bit (Yes or No)
14



INTRODUCTION TO CONFLICTMANAGER
Component GUID (Windows Installer installations only)

KeyPath (Windows Installer installations only)

Resource count (Windows Installer installations only)

Shared .DLL (Windows Installer installations only)

Registry key value

This information is displayed in the Resolve wizard, which you start by 

selecting Resolve from the Conflicts menu. The information is also 

displayed in the Properties dialog box, which you open by double-clicking 

the conflicting item in the right pane of the Application Explorer.

What Kind of Conflicts Does ConflictManager Find?
ConflictManager finds and lets you resolve conflicts caused by different 

applications that install files with the same name. To save time during 

conflict detection, ConflictManager only searches for the following 

situations:

• Duplicate files, of any type, in the Common Files directory and any 

subdirectory of Windows, including the System directory. For example, if 

two different applications both install the file readme.txt in the Common 

Files directory, ConflictManager marks them as conflicts. If you don’t 

want ConflictManager to find conflicting readme.txt files, you can 

exclude that file, or any other files you don’t care about, from the 

conflict detection.

• Duplicate executable files only (.EXE, .DLL, and .OCX files) in all other 

directories. For example, if two applications install sslib.dll in the 

Program Files directory, it is considered a conflict.

In addition to file conflicts, ConflictManager also finds conflicts that occur 

when two or more applications install the same system resource, such as 

registry keys, Autoexec.bat, Config.sys, ODBC, NT services, devices, .INI 

files, shortcuts, and the PATH variable. Experienced users can resolve 

registry key conflicts in ConflictManager. The other types of conflicts cannot 

be resolved in ConflictManager and are displayed for informational 

purposes only. For more information about conflict types, see Types of 

Conflicts on page 29.
15



2: CONFLICTMANAGER BASICS
Starting ConflictManager

ConflictManager is one of the tools included in Wise Package Studio. 

Typically, you start ConflictManager from the Projects tab by running a tool 

or task that is associated with ConflictManager. You can also start 

ConflictManager from the Tools tab by double-clicking the ConflictManager 

icon.

To start ConflictManager:

Start ConflictManager from Wise Package Studio in either of two ways:

• From the Projects tab, click the Run link to the right of the task or tool 

associated with ConflictManager.

OR

• From the Tools tab, double-click the ConflictManager icon.

The ConflictManager program opens. You can now detect, retrieve, and 

resolve conflicts for the application of your choice.

• The first time you start ConflictManager, it opens the default database, if 

you specified one during installation. Typically this database is empty. If 

this database is shared, it might contain applications imported by other 

users. If you imported sample applications during installation, they 

appear in the database.
16



STARTING CONFLICTMANAGER
• The first time you start ConflictManager, if you skipped the database 

setup during installation, the Select Data Source dialog box appears and 

you must connect to a database. See Opening a ConflictManager 

Database on page 47.

• If one or more installations have been distributed to the ConflictManager 

share point, the Import from Share Point dialog box appears 

automatically. You can select applications and click OK to import them, 

or click Cancel to start ConflictManager without importing applications. 

See Importing From the ConflictManager Share Point on page 73 for 

more information.

• If the database contains applications but conflicts have not been 

detected yet, the Detect Conflicts dialog box appears automatically. You 

can select applications and click OK to detect conflicts, or click Cancel to 

start ConflictManager without detecting conflicts. See Detecting 

Conflicts on page 84 for more information.

If you’re new to ConflictManager, you might want to open the sample 

applications database and experiment with finding and resolving conflicts. 

See Using the Sample Applications Database on page 39.
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2: CONFLICTMANAGER BASICS
The ConflictManager Interface

When you start ConflictManager, you see the main ConflictManager 

window. Some of the panes might be empty if you have not imported any 

applications or detected conflicts. Importing applications populates the 

database with information about the applications. Detecting conflicts finds 

conflicts between one or more selected applications and all other 

applications in the database. Retrieving conflicts displays the conflicts for 

an application you choose.

Areas of the ConflictManager Window
Conflict List. This pane initially appears at the top of the window, and lets 

you view conflicts between an application and the rest of the database. You 

choose an application and package, and other filtering criteria, and click 

Retrieve. The right pane of the Conflict List shows all conflicts between the 

selected application and all other applications in the database. When you 

click a conflict item in this pane, the tree structure in the Application 

Explorer automatically expands to show the location of the conflict. In the 

Enterprise Edition, if a group is selected, only the conflicts between the 

selected application and the applications in the group appear.

Conflicts are classified as either warnings, errors, or information. See What 

Are Warning, Error, and Information Conflicts? on page 30 for descriptions 

of these conflict classifications.

Application 
Explorer. Shows 
the installations 
that you’ve 
imported into the 
database.

The right pane of 
the Application 
Explorer shows the 
contents of the 
folder selected in 
the left pane.

Conflict List. 
Choose the 
application and 
package for which 
you want to display 
conflicts, then click 
Retrieve.

When you retrieve 
conflicts, this pane of 
the Conflict List 
displays all the conflicts 
between the selected 
application and the rest 
of the database. 
Double-click an item to 
see the items that 
conflict with it.

Groups. This pane 
shows the groups 
you’ve defined. Select a 
group to show conflicts 
between the selected 
application and the 
subset of applications 
that’s defined by a 
group. Enterprise 
Edition only.

Status Bar. Shows the conflict detection 
status. “Idle” displays when conflict detection 
is not running.
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Application Explorer. The Application Explorer initially appears in the 

lower left of the window. The left pane of the Application Explorer shows all 

applications that are in the current ConflictManager database. You can see 

all the file, registry, and .INI modifications made by each installation by 

expanding the tree structure beneath its name. The three icons in this 

pane are:

 Group Icon. In the Enterprise Edition, this icon represents the group 

that you are currently viewing. “All Applications” is considered a group 

(it is the only group in the Professional Edition). You choose a group in 

the Groups pane, which you open by selecting Groups from the View 

menu.

 Application Icon. This icon represents an application installation that 

is in the ConflictManager database.

 Package Icon. This icon represents the different versions of a single 

application installation. For instance, the Microsoft Office application 

installation might contain two packages, Office 97 and Office 2000. 

Packages are differentiated in the database so ConflictManager can 

avoid showing conflicts between different packages of the same 

application.

The right pane of the Application Explorer contains the conflicts that are 

located in the folder that’s selected on the left. This lets you see conflicts 

by location in the installation.

Groups. The Groups pane, accessed by selecting Groups from the View 

menu, initially appears in the lower right of the window, and shows groups 

you defined. You use groups to see conflicts between a given subset of 

applications. Normally, when you click the Retrieve button, the selected 

application is compared against every other application in the database. If 

you only want to see conflicts within a particular group of applications, you 

can create a group of applications and display conflicts only within that 

group.

Enterprise Edition only

Groups are available in the Enterprise Edition only.
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Customizing Your Workspace
To customize the ConflictManager window, you can show or hide its panes, 

resize the panes, and dock and undock the Groups pane and the Conflict 

List pane.

To show or hide panes:

Hide or show the Status Bar, Conflict List, or Groups pane by selecting its 

name from the View menu.

To resize panes:

Adjust the height or width of any ConflictManager pane, whether docked or 

undocked, by dragging its border.

To dock and undock panes:

To undock the Conflict List or Groups pane, click anywhere in the gray area 

of the pane and drag it towards the center of the window.

To dock the Conflict List, drag it to the top or bottom of the 

ConflictManager window. To dock the Groups pane, drag it to the left or 

right of the ConflictManager Window. The Conflict List can dock only at the 

top or bottom; the Groups pane can dock only on the left or right.

Enterprise Edition only

The Groups pane is available in the Enterprise Edition only.
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Using ConflictManager in a Multi-user 
Environment

Most organizations that use ConflictManager use it in a multi-user 

environment. Users can run ConflictManager from their local computers or 

from a server installation. When users select a network directory as the 

Destination Directory during installation, the ConflictManager program 

files are installed on a server and the users’ computers are configured to 

run the software from the server. Regardless of how they run 

ConflictManager, users can access a single ConflictManager database that 

is stored on the server.

When you use ConflictManager in a multi-user environment:

• Multiple users can distribute to the ConflictManager share point.

• When an application is imported to ConflictManager, whether 

automatically or by a user, all ConflictManager users can view it and 

detect conflicts against it.

• Multiple users can resolve conflicts, provided each user resolves 

conflicts for a different application.

Typically, each user is assigned to work on a specific application or 

applications. Users detect and resolve conflicts for their assigned 

applications. Your company standards should determine whether a user 

can update an application that is assigned to someone else. This could 

happen when using one of the aggressive resolution rule sets or when 

using the Copy Down button in the Resolve wizard.
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ConflictManager Professional and 
Enterprise Editions

ConflictManager is available in the Professional and Enterprise editions of 

Wise Package Studio. The Professional Edition is designed for system 

administrators working as part of a desktop integration team at a 

department or division level within an organization. It contains a powerful 

set of features for detecting and resolving conflicts between applications. 

The Enterprise Edition contains the following advanced features designed 

for the corporate repackaging team:

• Auto Import Service imports applications into the ConflictManager 

database automatically. See Running the Auto Import Service on 

page 76.

• Application groups let you organize imported applications into groups, 

which reduces the number of conflicts you view at one time. See 

Grouping Applications on page 80.

• User-defined conflict resolution rules let you modify the predefined rule 

sets or create your own to reflect your company’s standards. See 

Creating a New Rule Set on page 66.

• Additional conflict reports that show conflicts for multiple applications 

and groups. See What Reports Are Available? on page 106.
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The ConflictManager Process

ConflictManager provides an efficient way to detect and resolve potential 

conflicts before you deploy applications across your organization’s 

workstations. Before you begin to use ConflictManager, however, you must 

set up your work environment by connecting to a database, defining 

conflict settings. If you are using the Enterprise Edition, you might also 

want to customize conflict resolution rules. Once you have set up 

ConflictManager, you can import applications into the database, detect 

conflicts between applications, resolve conflicts, export the changed 

applications, and test the modified installations.

Before You Start to Use ConflictManager
Before you can start resolving application conflicts, you must set up your 

ConflictManager work environment. This consists of connecting to or 

creating a database, defining conflict settings, and defining resolution 

rules.

• Connect to or create a database. The ConflictManager installation 

process sets your default ConflictManager database. If you choose to 

use an Access database for ConflictManager, it is created automatically 

in the Wise Package Studio share point directory during installation. If 

you want to use an MSDE or SQL Server database instead, you must 

create the database and register it as a data source either before or 

after installing ConflictManager.

When you first start ConflictManager, it opens your default database. If 

you want to use a database other than the default, or if you did not 

connect to a database during installation, you must create a database, 

register it as a data source, and then open it in ConflictManager. See 

Opening a ConflictManager Database on page 47 and Creating a New 

ConflictManager Database on page 48.

• Define conflict settings. Conflict settings determine the type of 

conflicts that are detected and the items, such as files and registry keys, 

that are excluded from the conflict detection. Excluding files and registry 

keys helps eliminate conflicts that don’t have a negative impact on any 

installation. You define ConflictManager settings in the Conflict Settings 

dialog box, which you access by selecting Conflict Settings from the 

Setup menu. For more information, see Defining Conflict Settings on 

page 56.

• Define conflict resolution rules. Conflict resolution rules let you 

resolve conflicts automatically, which saves time, reduces errors, and 

provides consistency in conflict resolution. ConflictManager contains four 

predefined rule sets you can use.
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If you have the Enterprise Edition, you can modify the existing rule sets 

or create your own to meet your needs. Rule sets are stored with the 

database, therefore, if you use multiple ConflictManager databases, you 

must define rule sets separately in each one. To define resolution rules, 

select Conflict Resolution Rules from the Setup menu. See Using Conflict 

Resolution Rules on page 64.

Process for Resolving Conflicts
Rather than depending on the trial and error method of finding conflicts—

that is, by installing an application and waiting for it to crash—you can 

approach the problem systematically with ConflictManager. You first obtain 

a Windows Installer or WiseScript installation file for each application you 

want to check for conflicts. If you want to check an application that is not in 

either of those formats, use Wise Package Studio to repackage it. Then 

import each application into a ConflictManager database, where you use 

ConflictManager to compare applications and find potential conflicts.

Typically, you follow the general process listed below to use 

ConflictManager. In some cases you might not follow all these steps, and 

often you might not follow them in order. If you are using ConflictManager 

for the first time, however, the steps below help familiarize you with 

different parts of the process.

Step 1: Define Applications

Before using ConflictManager to find conflicts, you need definitions of all 

the application installations that you need to compare. Each application 

must be in WiseScript (.WSE) format or Windows Installer (.WSI or .MSI) 

format. You can obtain application installations in different ways.

• If you’re a software developer or your company uses in-house custom 

applications, you can build your installation in a Wise authoring tool 

such as Windows Installer Editor.

• Use an existing third-party Windows Installer or WiseScript installation.

• Use SetupCapture, ApplicationWatch, or other Wise Package Studio 

tools to repackage a third-party installation into WiseScript or Windows 

Installer format. See the Wise Package Studio Reference Manual for 

more information on the Package Studio tools.

• Use the predefined applications that are shipped with ConflictManager’s 

sample database.
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Step 2: Prepare Installations for Import into 
ConflictManager

Whether you built an installation in a Wise product or used Wise Package 

Studio to convert a third-party installer into WiseScript or Windows 

Installer format, you need to import the installation into ConflictManager. 

You can prepare installations for import into ConflictManager in the 

following ways:

• Distribute to the ConflictManager share point. You can use the 

Distribution Wizard to distribute an application installation to the 

ConflictManager share point directory. This is the recommended way to 

distribute applications that you plan to import into ConflictManager.

• Distribute the installation to any network or local drive. Use the 

Distribution Wizard to distribute the installation and its associated files 

to any network or local directory.

• Save the installation to any network or local drive. If you are not 

using ConflictManager in a multi-user environment, simply save the 

installation on your computer.

Note:

In order to export an application after resolving its conflicts, you must 

have access to the original installation and its associated files.

For more information about the Distribution Wizard, see the topic titled 

Distribution Wizard in the Wise Package Studio Help.

Step 3: Import Application Installations into 
ConflictManager

After you prepare installations for import, use ConflictManager to import 

them into the ConflictManager database. You can import application 

installations in the following ways:

• Import from the ConflictManager share point. If you or a coworker 

used the Distribution Wizard to distribute installations to the 

ConflictManager share point, import them into ConflictManager by 

selecting Import from Share Point from the Application menu. If you 

have the Enterprise Edition, you can use the Auto Import Service to 

import applications automatically. See Importing From the 

ConflictManager Share Point on page 73.

• Import from any network or local drive. If you or a coworker used 

the Distribution Wizard to distribute an installation to a network drive, 

or if an installation was saved to a local drive, import the installation 
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into ConflictManager by selecting Import from the Application menu. 

See Importing From a Network or Local Drive on page 78.

• Distribute directly to the ConflictManager database. The 

Distribution Wizard can distribute an application installation directly to 

the ConflictManager database. When you use this distribution method, 

the application automatically appears in the database the next time you 

open the database in ConflictManager.

Note:

Distributing directly to the ConflictManager database does not copy any 

files, so you cannot recompile the application after resolving its conflicts. Use 

this method only when you plan to use ConflictManager as a reporting tool.

Step 4: Detect Conflicts

After importing all the application installations that you need into 

ConflictManager, you can find conflicts by selecting Detect from the 

Conflicts menu. You choose one or more applications for which to find 

conflicts, which populates the database with conflict information for those 

applications you chose. ConflictManager identifies conflicts in files, registry, 

Autoexec.bat, Config.sys, ODBC, NT services, devices, .INI files, shortcuts, 

and path additions.

To actually see the conflicts, you use the Retrieve button in the left pane of 

the Conflict List. You can only retrieve conflicts for one application at a 

time. You can use the Reports menu to display and print conflict 

information in varying formats.

See Detecting Conflicts on page 84 and Reviewing Conflicts on page 86 for 

more information.

Step 5: Resolve Conflicts

The process of resolving a conflict involves looking at each file that has a 

conflict and choosing which version should be installed on the destination 

computer. You can also choose to change the location of conflicting files so 

that each application can use its respective version of the file. To resolve 

file conflicts for a particular application, select either Resolve or Resolve 

with Rules from the Conflicts menu. The Resolve command runs the 

Resolve wizard, which lets you review and resolve file conflicts individually. 

The Resolve with Rules command uses conflict resolution rules to resolve 

conflicts automatically. See Resolving Conflicts on page 91 for more 

information.
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Step 6: Save Resolved Application Installations

The final step in the ConflictManager process is to save the changes you 

made to the installation back to the original WiseScript (.WSE) or Windows 

Installer file (.WSI), which you then recompile. You can also export to the 

original .MSI, which you do not need to recompile. This produces an 

installation that does not conflict with other applications on your company’s 

computers. ConflictManager provides two ways to save installation 

changes:

• Export. Writes an application’s database information to an installation 

file. After you export an installation you must compile it in either the 

Windows Installer Editor or WiseScript Editor.

• Export and Recompile. Exports all applications whose conflicts have 

been resolved. An option lets you recompile the applications 

automatically after exporting.

See Exporting Applications After Resolving Conflicts on page 100 for more 

information.

Step 7: Testing Your Repackaged Installation

After you save and recompile a resolved installation, you should install it on 

a clean machine and test it to make sure it works. If it does not work, 

return to ConflictManager and redo the conflict resolution, either 

individually with the Resolve wizard or automatically with rules.

Note:

It is important to test your application on a clean machine. A machine that is 

not clean might contain newer versions of some of the files you resolved. Because 

these newer files are not overwritten during the installation, you do not get a true 

representation of your resolved installation.

• To redo the conflict resolutions with the Resolve wizard, select Resolve 

from the Conflicts menu. In the wizard, select one or more files, then 

use the Revert button to undo your previous conflict resolutions for 

those files. Then try other ways to resolve the conflicts. Use this method 

when you want to revert changes for just one or a few files.

• To redo the conflict resolutions automatically with rules, select Resolve 

with Rules from the Conflicts menu and select a different rule set. This 

reverts all the previous conflict resolutions for that application and then 

resolves them using the different rule set.

• To revert all previous resolutions without applying a new rule set, select 

Resolve with Rules from the Conflicts menu and select the Restore 

original conflicts rule set. This reverts all previous conflict resolutions 
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but does not resolve the conflicts. Later, you can resolve conflicts with a 

different rule set or with the Resolve wizard.

After you redo the conflict resolutions, repeat the steps to save, export, 

and compile the application. Then install it on a clean machine and test it 

again.
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Types of Conflicts

You use ConflictManager primarily to find file conflicts, but it can find other 

types of conflicts as well. Each type of conflict has an associated icon that 

appears to the left of the conflict item in the Conflict List and Application 

Explorer. Following is a list of the types of conflicts and their icons.

 Files and components. Files with identical names that are installed at 

the same location by more than one application. Windows Installer 

components that have matching key files, but one or both contain 

additional non-advertising resources. Also, Windows Installer components 

that have additional resources that conflict with a file in a WiseScript 

installation.

 Registry. Registry keys and named values that are set differently by 

more than one application.

 Autoexec.bat. Modifications to Autoexec.bat that are made by more 

than one application. These errors do not occur in Windows Installer 

installations.

 Config.sys. Modifications to Config.sys that are made by more than 

one application. These errors do not occur in Windows Installer 

installations.

 ODBC. ODBC data source and driver conflicts that occur when the 

registry entries of two or more applications configure the same driver 

differently.

 Service. Windows NT services of the same name that are installed by 

more than one application.

 Device. Device drivers that are installed in Win.ini by more than one 

application. These errors do not occur in Windows Installer installations.

 .INI file. .INI files and entries that are changed by more than one 

application.

 Shortcut. Shortcuts of the same name that are installed by more than 

one application.

 Path. Changes to the PATH variable made by more than one 

application. These errors do not occur in Windows Installer installations.
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What Are Warning, Error, and Information 
Conflicts?

Conflicts are classified as either warnings, errors, or information. When you 

display conflicts, these classifications are indicated by an icon to the left of 

the conflict type icon.

 Warning. Warnings represent possible conflicts. A warning conflict 

occurs when two installation packages install a non-16-bit file with the 

same file name but different file information (file version number or date/

time) to different directories. This type of conflict is not critical but might 

warrant some attention.

 Error. Errors are the more serious conflicts and deserve careful 

inspection. Errors can occur in the following situations:

• When two or more installations install files of the same name to the 

same directory, but the component GUIDs do not match.

• When two or more installations install a non-16-bit file of the same 

name with different file information to the same directory.

Note:

Because 16-bit .DLLs are shared by all applications, any 16-bit .DLLs 

installed to different directories with the same file name but different file 

information are marked as errors.

• When Windows Installer components have matching key files, but one 

or both contain additional non-advertising resources. Also, when 

Windows Installer components have additional resources that conflict 

with a file in a WiseScript installation.

• When two or more installations set the same registry key to different 

values.

For a list of other possible errors, see Guidelines for Resolving File Conflicts 

on page 31.

 Information. Information conflicts occur when two or more installation 

packages install a non-16-bit file with identical file information to the same 

directory or to different directories. Information conflicts also occur when 

two or more installation packages set the same registry key to the same 

value. These are not true conflicts, therefore they do not appear in the 

Conflict List. You can see them, however, by browsing through the 

Application Explorer.
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Guidelines for Resolving File Conflicts

This section provides guidelines for resolving various types of file conflicts. 

Use them to help you resolve file conflicts. If you are using the Enterprise 

Edition, you can also use these guidelines to help you set up conflict 

resolution rules. The advantage of using conflict resolution rules is that you 

don’t have to analyze each individual conflict; the Resolve with Rules 

function does the analysis for you.

When you resolve a conflict with the Resolve wizard, you must first 

determine the conflict type. You do this by analyzing the file conflict 

information in either of two ways:

• Look at the file conflict information displayed in the Resolve wizard, 

which you start by selecting Resolve from the Conflicts menu.

• Look at the Conflicts tab of the Properties dialog box, which you open by 

double-clicking the conflicting item in the right pane of the Application 

Explorer.

In the Resolve wizard and the Properties dialog box, you can see each 

conflicting file’s version, date/time, size, and other information that lets 

you determine what is causing the conflict.

The following table lists the types of file conflicts that can occur and 

recommends how to resolve them. The Conflict column list the types of file 

conflicts possible. The Problem column explains what can happen if the 

conflict is not resolved. The Recommended Resolution column describes in 

general terms how to resolve the problem, then lists the rule action to use 

if you are setting up conflict resolution rules. It also tells you the button to 

click to resolve the problem in the Resolve wizard.
31



2: CONFLICTMANAGER BASICS
Conflict Problem Recommended Resolution

Two files with the 

same name have 

different version, date/

time, or size.

If the installation does not 

use versioning rules 

(WiseScript replacement 

options or the Windows 

Installer REINSTALLMODE 

property), the older 

version can install over the 

newer version, causing a 

problem when each 

application requires a 

specific version of the file. 

Also, the new file might 

not be compatible with the 

old one.

Copy the file information (source path 

included) from one application to 

another, or isolate the file. For more 

information on resolving these conflicts, 

see When to Resolve Conflicts by 

Copying File Information on page 33 and 

When to Resolve Conflicts by Isolating 

Files on page 34.

Two files with the 

same name are 

installed to the same 

directory, but 

component GUIDs do 

not match.

After both applications are 

installed, uninstalling one 

of them will remove the 

file, essentially breaking 

the application that is left.

Match GUIDs for identical files across 

applications.

Use the rule action Replace the MSI 

component GUID with the matching 

conflicting file’s GUID. If you’re using the 

Resolve wizard, use the Copy Up button.

OR

Use the rule action Use the MSI 

component GUID in the active application 

to replace the MSI component GUID in 

the conflicting applications. If you’re 

using the Resolve wizard, use the Copy 

Down button.

File is KeyPath to one 

component, but not 

another.

After both applications are 

installed, uninstalling one 

of them will remove the 

file, essentially breaking 

the application that is left.

Make both files KeyPaths to their 

respective components.

Use the rule action Use the MSI 

component KeyPath in the active 

application to replace the MSI component 

KeyPaths in the conflicting applications, 

or the rule Replace the MSI component 

KeyPath with the matching conflicting 

file’s KeyPath. If you’re using the Resolve 

wizard, use the Fix Comp button.
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When to Resolve Conflicts by Copying File 
Information

When you resolve a conflict by copying file information, you either replace 

the active application’s file with the matching conflicting file or replace the 

conflicting files with the active application’s file. It usually is safe to copy 

file information when one file is simply a newer version of the same file, 

that is, all information is the same except version, date/time, or size. An 

exception is when the older file is substantially larger than the newer file. 

The older file might contain functions that the new version does not. In this 

case, you might have to experiment to find which file works best.

Note:

In some rare cases, two files have the same name but different values in the 

Company field, meaning they were created by different manufacturers. These 

errors are difficult to resolve, because the two files might be entirely different. If 

they’re .DLL files, they might have entirely different APIs and different functions. In 

this situation it is best to isolate the files. For help, see When to Resolve Conflicts by 

Isolating Files on page 34.

The shared .DLL 

counter is not set for a 

file shared by a 

WiseScript application 

and a Windows 

Installer application.

In a mixed WiseScript/

Windows installer 

environment, shared .DLL 

counters must be set so 

the WiseScript’s shared 

.DLL reference counts are 

up to date. Otherwise, 

uninstalling either 

application will break the 

other.

Set the Shared .DLL flag on one or both 

files.

Use the rule action Set shared DLL 

counters if required. If you’re using the 

Resolve wizard, use the Fix Comp button.

Two Windows Installer 

components have 

matching key files, but 

one or both contain 

additional non-

advertising resources. 

Or, one component has 

additional resources 

that conflict with a file 

in a WiseScript 

installation.

If the KeyPath file already 

exists during installation, 

the entire component is 

not installed, resulting in 

the additional resources 

not being installed.

Break out the non-advertising resources 

into their own component.

Use the rule action Move non-advertising 

resources into different component. If 

you’re using the Resolve wizard, use the 

Fix Comp button.

Conflict Problem Recommended Resolution
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To resolve conflicts by copying file information:

You can copy file information in any of the following ways:

• Use the rule action Replace the active application’s file with the 

matching conflicting file with a condition to compare the application file 

version to the conflicting files, and sort by version.

If you’re using the Resolve wizard, use the Copy Up or Latest button.

This is the more conservative way to resolve conflicts because it does 

not affect other applications.

OR

• Use the rule action Replace the conflicting files with the active 

application’s file with a condition to compare the application file version 

to the conflicting files.

If you’re using the Resolve wizard, use the Copy Down button.

This is the more aggressive way to resolve conflicts because it changes 

other applications. You must export, recompile, and test any other 

applications that you change.

When to Resolve Conflicts by Isolating Files
Isolating files is generally safer than copying them. You should isolate files 

to resolve conflicts when:

• Two applications install the same executable file (.DLL, .OCX, or .EXE) to 

the System directory or to any common directory.

• Two files have the same name but they are not different versions of the 

same file, especially if the Company (manufacturer) is different.

You resolve the conflict by moving one or both of the files to their 

respective application directories and telling the operating system to look 

in that directory before looking in the System directory. You can accomplish 

this with application paths (AppPaths) or, in Windows 98 SE, Windows 

2000, Windows XP, and Windows Me environments, you can accomplish 

this with isolated components. Moving a file that is not listed in the registry 

is generally safe because it’s certain that no programs will try to find it by 

looking in the registry.

Important Note:

When you isolate a file, the file is still copied to the System directory in 

addition to the application directory. If the System directory already contains an 

earlier version of the file, the earlier version is replaced. This could cause a problem 

in any application that uses the earlier version of the file. Therefore, it is best to 

isolate both versions of the file.
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If the conflicting files are listed in the registry, using an application path to 

move them to a private application directory can cause problems. 

ConflictManager updates the registry when a file is moved to a private 

application directory. This can cause other applications to follow the moved 

file and result in a further conflict. You might need to experiment to find 

which applications find the file via the registry and which simply look in the 

path. Then you can move the .DLL for the applications that look at the 

registry entry, and leave a copy in the System directory for applications 

that look in the path.

When an application has conflicting files that are listed in the registry, and 

it is intended for installation on Windows 98 SE, Windows 2000, Windows 

XP, or Windows Me, you can use isolated components to move the 

conflicting files. This usually does not cause problems.

To isolate a file when using the Resolve wizard:

1. From the Conflicts menu, select Resolve.

2. On the Welcome dialog box, select an option from the Isolation 

Method drop-down list:

• Choose Do not move files to disable the Move button in the File 

Conflicts and File Conflicts in Registry dialog boxes.

• Choose Isolated Components if the application will be installed 

only in a Windows 98 SE, Windows 2000, or Windows Me 

environment.

• Choose Application Paths if the application will be installed in any 

Windows environment.

3. If you choose Application Paths, enter the directory path where 

Windows should look for the files in the Path field. This path is created 

under the main application directory.

4. Click the Next button and resolve conflicts as described in Resolving File 

Conflicts Individually With the Resolve Wizard on page 92.

To isolate a file when resolving with rules:

Enterprise Edition only

The ability to create rules is available in the Enterprise Edition only.

Create a rule containing the action Isolate the file via [AppPaths OR 

Isolated Components]. Set this action’s variable as follows:

• Choose Isolated Components if the application will be installed only in 

a Windows 98 SE, Windows 2000, or Windows Me environment.
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• Choose AppPaths if the application will be installed in any Windows 

environment.

When you choose this variable, a second line is added to the action: into 

the directory Shared. If you leave this line as is, the application path is 

set to a directory named Shared under the main application directory. To 

use a different application path, click the word “Shared” and type a new 

directory name.
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The ConflictManager 
Database

The ConflictManager database contains information about application 

installations, their conflicts, and the conflict resolutions. It also contains 

conflict resolution rules and, in the Enterprise Edition, application groups.

In this section, learn about:

• ConflictManager databases.

• The ConflictManager share point and index.

• Using the Network Index Properties dialog box.

• Working with ConflictManager databases.
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About ConflictManager Databases

The ConflictManager database stores information about imported 

applications and their conflicts. You can use Microsoft Data Engine (MSDE) 

or Microsoft Access database as your ConflictManager database. If you 

have the Enterprise Edition, you also can use a Microsoft SQL Server 

database. Using SQL Server is recommended for a large integration team 

because the amount of data required for managing a large number of 

applications requires the performance of SQL Server. The ConflictManager 

installation process always creates an Access database, named 

Applications.mdb, and registers it as a data source. If you want to use an 

MSDE or SQL Server database instead, you must create the database and 

register it as a data source. You can connect to the MSDE or SQL data 

source either during or after installation.

In a multi-user environment, the ConflictManager database should reside 

in a shared network directory so it can be accessed by multiple users at 

once. If you choose to use a Microsoft Access database, it is installed 

automatically in the directory designated as the share point during the 

Wise Package Studio installation.

The options on the Select Database Type dialog box in the Wise Package 

Studio installation determine the default ConflictManager database. If you 

choose Microsoft Access as the database type, Applications.mdb is set as 

your default ConflictManager database. If you choose Microsoft Data 

Engine (MSDE) or Microsoft SQL Server as the database type, you 

must specify the MSDE or SQL Server database that you have already 

created. That database is then set as the default ConflictManager 

database. If you do not connect to a database during installation (if you 

choose the Skip database setup option), you must do so afterwards.

If you connected to a database during installation, the default database 

opens automatically when you first start ConflictManager. Otherwise, you 

must connect to the database when you first start ConflictManager. You 

add data by importing your applications; see Importing Applications Into 

the Database on page 72. You can also import application data from 

SampleApplications.mdb; see Using the Sample Applications Database on 

page 39.

You can create additional ConflictManager databases. For example, if you 

are repackaging a large number of applications for a large organization, 

you might want to set up a separate database for each division or 

department. See Using Multiple Databases on page 39.

You also can use a database created for a previous version of 

ConflictManager. The first time you open an older ConflictManager 

database, its format is updated automatically.
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Using Multiple Databases
A single ConflictManager database is sufficient for most organizations. 

However, you might want to use multiple databases in these instances:

• If you are repackaging a large number of applications for a large 

organization, you can use multiple databases to reduce the database 

size and thus reduce the time it takes to detect conflicts within each 

database.

• If you are repackaging for multiple operating systems, you can use a 

separate database for each target operating system.

• If your organization has multiple departments, each using a different set 

of applications, you can use a separate database for each department. 

This concept is similar to using application groups, but on a larger scale. 

For more information about groups, see Grouping Applications on 

page 80.

Each ConflictManager database should reside in a separate share point 

directory on its own server. Running multiple databases on a single server 

degrades performance. In addition, you cannot run the Auto Import 

Service, which imports applications automatically on a server-based 

installation, on more than one database on a single computer. For more 

information, see Creating a New ConflictManager Database on page 48.

Using the Sample Applications Database
ConflictManager ships with a sample applications database, named 

SampleApplications.mdb, that contains installation information for a 

number of commonly-used application packages. The sample applications 

database is located in the share point directory. You can use this sample 

database as follows:

• You can open the sample database directly and use it to explore and 

learn ConflictManager before you start entering and processing live 

data.

• You can import the sample applications into your ConflictManager 

database, to provide a starting point for finding conflicts with your 

applications. You can delete the sample applications from your database 

at any time.

If you did not import the sample applications into your ConflictManager 

database during the Wise Package Studio installation, you can use the 

Copy ConflictManager Applications utility to do so at any time. See 

Copying Data Between Databases on page 49.
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About the ConflictManager Share Point and 
Index

When you install Wise Package Studio, you specify the location of the share 

point directory. This directory stores information created and used by 

Package Studio and ConflictManager.

The share point directory contains a subdirectory, named scripts, that 

stores distributed installation scripts and Windows Installer files. The 

scripts directory is created the first time you use the Distribution Wizard to 

distribute to the ConflictManager share point. The scripts directory also 

stores .QUE files, which are temporary files representing applications that 

have been distributed but not yet imported into ConflictManager. After you 

import the applications into ConflictManager, the .QUE files are deleted.

When you use the Distribution Wizard to distribute to the ConflictManager 

share point, additional subdirectories are created under the share point. 

These subdirectories store files associated with each application’s 

installation. The subdirectories are numbered sequentially, as in 000\001, 

and so on. An index file, wamdb.idx, records the location of the files.

The share point directory also contains the Sample Applications database 

as well as the default Access-based ConflictManager database, if you 

choose to install it.

A common question is “Can I clean up the share point by deleting unused 

files after resolving conflicts?” The answer is no. It is too difficult to know 

which files are safe to delete. Also, ConflictManager lets you revert 

resolved applications to their original state, but if you delete an 

application’s original files, you cannot revert.

Indexing Files With wamdb.idx
When you distribute to the ConflictManager share point, a sequentially-

numbered directory structure is created to store occurrences of files. An 

index file named wamdb.idx, located in the share point directory, records 

the location of files. For example, assume you have three installations, 

each containing a version of report.dll. The first time you distribute an 

installation containing report.dll, it is placed in the Share Point\000\001 

directory. If you distribute an installation containing the same version of 

report.dll, a counter is set for that file in wamdb.idx; the file is not saved a 

second time. If the third installation uses a different version of report.dll, it 
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is stored in a second directory, Share Point\001\002. The result is a set of 

all the unique files across all your installations. Because of the indexing of 

files, distributing to the share point eliminates storage of duplicate files and 

results in smaller storage requirements than if you distribute to a network 

directory.

QUE Files and Automatic Importing
When you use the Distribution Wizard to distribute to the ConflictManager 

share point, temporary files are created in the share point directory. These 

files, which have the same name as the installation file but with the 

extension .QUE, represent applications that have been distributed but not 

imported into ConflictManager. The .QUE files are removed after you import 

the applications they represent into ConflictManager.

Distributing to the ConflictManager share point lets you import applications 

into ConflictManager in any of these three ways:

• If you are running the Auto Import Service in the Enterprise Edition, the 

service periodically searches the share point for .QUE files and, when it 

finds one, imports that application into the ConflictManager database 

automatically.

• If the share point contains .QUE files when you start ConflictManager, it 

displays the applications and lets you import them.

• If you do not import an application when you start ConflictManager, or if 

an application is distributed to the share point after you start 

ConflictManager, you can use the Import from Share Point command on 

the Application menu.
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Using the Network Index Properties Dialog 
Box

ConflictManager contains a menu command, Network Index Properties, 

that lets you maintain the server path and database index.

• You can change the server path, which is the path where files associated 

with an installation are stored. If the drive with the original server path 

becomes full, you can create a new server path on a different drive and 

set it as the new default. See Adding Server Paths.

• You also can restructure the index, and you can rebuild the index if it 

becomes corrupted. See Restructuring the Index on page 45 and 

Rebuilding the Index on page 46.

Warning:

Do not change the contents of the Index Location field in the Network 

Index Properties dialog box. Changing this field changes the share point value in 

Wise Package Studio, which means existing Package Studio tasks will not work.

Adding Server Paths
The ConflictManager server path is where the files associated with an 

installation are stored. Initially, the server path is the same as the share 

point directory. However, you can add new server paths. You might need to 

do this if you are repackaging a large number of applications and 

distributing to the ConflictManager share point, and the drive containing 

the share point directory becomes full. When that happens, you can create 

a new directory on another network drive, then use the Network Index 

Properties dialog box to set the new location as the “active” server path. 

The server path information is stored in the index file, wamdb.idx, which 

remains in the original share point directory.

ConflictManager can support up to 255 different server paths, but only one 

path can be active at a time. When you distribute to the share point, the 

installation’s associated files are placed in the active server path.

After you set a new active server path, when anyone distributes to the 

ConflictManager share point, the files associated with the installation are 

stored in the new active server path location. The installation script, .MSI, 

or .WSI, as well as the related .QUE file, are always stored in the original 

Share Point\scripts directory. Using an additional server path does not 

result in duplicate files. The files are still indexed to prevent file duplication 

across all server paths.
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Warning:

Do not change the contents of the Index Location field in the Network 

Index Properties dialog box. Changing this field changes the share point value in 

Wise Package Studio, which means existing Package Studio tasks will not work.

To change the active ConflictManager server path:

1. From the Setup menu, select Network Index Properties.

The Network Index Properties dialog box appears.

2. Click the Add button.

A Choose Server Path dialog box appears.
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3. In the Select Path field, specify the new server path, then click OK to 

return to the Network Index Properties dialog box.

4. In the Storage Paths list, click the new server path then click the 

Details button.

A Server Path Settings dialog box appears.

5. Mark the Active Path checkbox and click OK to return to the Network 

Index Properties dialog box.

The “Yes” in the Active column next to the new server path name 

indicates that this is now the active server path. Now, whenever 

someone distributes to ConflictManager share point, the associated files 

will be stored in the new path location.

6. Click OK to close the Network Index Properties dialog box.

Deleting a Server Path
You can delete a ConflictManager server path, but only if you have not yet 

added data to it. Do this if you add a new server path in the Network Index 

Properties dialog box, then realize that you mis-typed the name or selected 

the wrong path. This does not actually delete the directory path from the 

computer; it only deletes the path from ConflictManager. You cannot delete 

a server path that is active or that contains files.

Warning:

Do not change the contents of the Index Location field in the Network 

Index Properties dialog box. Changing this field changes the share point value in 

Wise Package Studio, which means existing Package Studio tasks will not work.

To delete a server path:

1. From the Setup menu, select Network Index Properties.

The Network Index Properties dialog box appears.
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2. If the server path you want to delete is currently active, set a different 

path to be the active one. In the Storage Paths list, click the server 

path you want to make active, then click the Details button.

In the Server Path Settings dialog box, mark the Active Path checkbox 

and click OK to return to the Network Index Properties dialog box.

3. In the Storage Paths list, click the server path you want to delete and 

click the Delete button.

4. The path is removed from the Storage Paths list.

Restructuring the Index
If, after you have used ConflictManager for some time, you find that 

distribution to the ConflictManager share point runs slower than it did at 

first, you might want to restructure the index by increasing the index block 

size, the hash table size, or both. This changes the index file, wamdb.idx. 

You do this in the Network Index Properties dialog box.

Note:

This procedure is intended for database administrators.

Warning:

Do not change the contents of the Index Location field in the Network 

Index Properties dialog box. Changing this field changes the share point value in 

Wise Package Studio, which means existing Package Studio tasks will not work.

To restructure the index:

1. From the Setup menu, select Network Index Properties.

The Network Index Properties dialog box appears.

2. In the Rebuild Index Settings section of the dialog box, you can 

increase the block size and hash table size.

• To increase the block size, select a higher number from the Block 

Size drop-down list.

• To increase the hash table size, enter a higher number in the Hash 

Table Size field.

3. From the Method drop-down list, select Rebuild using existing 

index file (not corrupt).

4. Click the Build button to begin the rebuild process.

The index is restructured. This can take some time, depending on the 

size of your database.
45



3: THE CONFLICTMANAGER DATABASE
5. When the Rebuild is Complete message appears, click OK.

Rebuilding the Index
If you encounter errors, such as the inability to copy files, while distributing 

to the ConflictManager share point, your database index (wamdb.idx) is 

probably corrupt. To resolve the database corruption and eliminate the 

distribution errors, you should rebuild the index. You do this in the Network 

Index Properties dialog box.

Note:

This procedure is intended for database administrators.

Warning:

Do not change the contents of the Index Location field in the Network 

Index Properties dialog box. Changing this field changes the share point value in 

Wise Package Studio, which means existing Package Studio tasks will not work.

To rebuild a corrupt index:

1. From the Setup menu, select Network Index Properties.

The Network Index Properties dialog box appears.

2. From the Method drop-down list, select the method to use to rebuild 

the index:

• Rebuild using file/directory structure. When you select this 

option, the rebuild process reads all files and directories in the 

ConflictManager share point and all its storage paths share points. 

This is the recommended method, as it gathers all possible 

ConflictManager data. This process can take quite a long time if your 

database contains a large number of applications.

• Rebuild using database data. Use this method only if all the 

applications you have distributed to the ConflictManager share point 

have been imported into ConflictManager. Because this method only 

reads the ConflictManager database, it does not record applications 

that have been distributed but not imported. This is the slowest 

method of rebuilding the index. There is no advantage to using this 

method.

3. Click the Build button to begin the rebuild process.

The index file is rebuilt. Expect this process to take a long time, even 

an hour or more, depending on the size of your database.

4. When the Rebuild is Complete message appears, click OK.
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Working With ConflictManager Databases

When you first start ConflictManager, it opens your default database, which 

is specified during installation. If you want to use a database other than 

the default ConflictManager database, or if you did not connect to a 

database during installation, you must create a database, register it as a 

data source, and then open it in ConflictManager. See Opening a 

ConflictManager Database and Creating a New ConflictManager Database 

on page 48.

You can copy data, including applications, conflicts, rule sets, and groups, 

from one ConflictManager database to another. For example, you might 

copy data from the ConflictManager Sample Database into a live 

ConflictManager database, if you did not do so during the Wise Package 

Studio installation. See Copying Data Between Databases on page 49.

If you are using an Access database in ConflictManager, it can eventually 

become fragmented and use disk space inefficiently. Use ConflictManager’s 

Compress Database utility to defragment the database file, decrease the 

size of the file, and free disk space. See Compressing an Access Database 

on page 50.

When an application becomes obsolete, you might want to delete it from 

the database. See Deleting an Application From the Database on page 51. 

In rare cases, you might want to delete all applications from a database. 

ConflictManager contains a menu command that deletes all applications, 

conflicts, rule sets, and groups. See Deleting the Contents of a Database 

on page 52.

Opening a ConflictManager Database
If you connected to a database during installation, the default database 

opens automatically when you first start ConflictManager. If you skipped 

the database setup during installation, or if you want to use a different 

database, you must open the database from ConflictManager. The 

database you open must have been created and registered as a data 

source.

To open a ConflictManager database, select Open Database from the File 

menu. A Select Data Source dialog box appears. This is a standard 

Windows ODBC connection wizard, which lets you connect to a database 

via an ODBC data source. If you need help connecting to a ConflictManager 

database, consult your organization’s database administrator.

The bottom of the File menu lists the last eight databases you opened. You 

can open a listed database by clicking its file name.
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The database you open becomes your default; it opens whenever you start 

ConflictManager, until you open a different database.

Creating a New ConflictManager Database
If you are repackaging a large number of applications, you might use 

multiple databases to reduce the size of the individual databases and thus 

reduce the time it takes to detect conflicts. You can create additional 

ConflictManager databases in Microsoft Access or Microsoft Data Engine 

(MSDE). If you have the Enterprise Edition, you can also create databases 

in Microsoft SQL Server.

To create a new database for use with ConflictManager, you simply create a 

blank database and register it as a data source. It is not necessary to 

create tables in the database; the first time you open the database in 

ConflictManager, you are prompted to have ConflictManager create the 

tables for automatically. You should set security on either the database or 

its directory, so that unauthorized users do not modify the database 

accidentally.

Note:

The following procedure assumes you are familiar with creating and 

registering either Microsoft Access, MSDE, or SQL Server databases. Wise Solutions 

does not offer technical support for Microsoft Access, MSDE, or SQL Server. See 

your company’s database administrator if you need assistance.

You can create a new database in a local or shared network directory. If 

you create the database in a shared directory, make sure each 

ConflictManager user has read and write access to the shared directory. If 

you have the Enterprise Edition and want to use the Auto Import Service to 

import applications automatically, you must create each database on a 

separate server with a separate ConflictManager server installation, 

because the Auto Import Service can import to only one database.

IMPORTANT:

Use only ConflictManager to modify this database.

To create a database for use with ConflictManager:

1. In Microsoft Access, MSDE, or SQL Server Enterprise Manager, create a 

blank database and specify a name and location.

2. Set up security for the new database if necessary.

3. Register the new database as a data source. How you do this depends 

on your operating system:
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• In Windows 95, Windows 98, Windows NT, and Windows Me, select 

the ODBC Data Sources icon from the Control Panel.

• In Windows 2000 or XP, select Administrative Tools from the Control 

Panel, then select Data Sources (ODBC).

4. Open the database in ConflictManager. See Opening a ConflictManager 

Database on page 47. The first time you open a new database, a 

warning message appears indicating that the database does not 

contains any tables.

5. Click the Yes button to create tables for the database.

6. When the Tables Created Successfully message appears, click OK.

The database opens in ConflictManager and is ready to use.

Copying Data Between Databases
ConflictManager ships with a Copy ConflictManager Applications utility that 

copies data from one ConflictManager database to another. The utility 

program, IMCopyDB.exe, is located in the ConflictManager directory under 

the Wise Package Studio application directory. It copies all applications, 

conflicts, rule sets, and groups from the source database to the destination 

database. You might use this utility to copy data from the ConflictManager 

Sample Database into a live ConflictManager database, if you did not do so 

during the Wise Package Studio installation.

Do not use this utility to copy data from an older version ConflictManager 

database to a new one, because it ignores the new database tables. If you 

want to use a database from a previous version of ConflictManager, just 

open it in ConflictManager and its format is updated automatically.

To copy data between databases:

1. In Windows Explorer, navigate to the ConflictManager directory under 

the Wise Package Studio application directory.

2. Double-click IMCopyDB.exe.

The Copy ConflictManager Applications dialog box opens.
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3. In the Source field, specify the database you want to copy from.

4. In the Destination field, specify the database you want to copy to.

5. Select an option in the Copy Method area:

• Replace Existing Applications. Overwrite all applications in the 

destination database with the applications in the source database.

• Append to Existing Applications. Add the applications in the 

source database to those in the destination database.

6. Click OK.

Data is copied from the source database to the destination database. If 

the source database is large, this can take a long time.

Compressing an Access Database
As you work in an Access-based ConflictManager database, adding and 

deleting applications, it can become fragmented and use disk space 

inefficiently. Use ConflictManager’s Compress Database utility to 

defragment the database file, decrease the size of the file, and free disk 

space. When you compress a database, unused data is removed and a 

defragmented copy of the database is created.

Access databases only

Use the Compress Database utility on Microsoft Access databases only.

A database does not compress for any of the following reasons:

• You don’t have enough storage space on your disk for both the original 

and compressed versions of the database. Delete any unneeded files 

and try again.
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• You don’t have permission for all tables in the database. If you don’t 

own this database, contact its owner to find out whether you can be 

given either Modify Design or Administer permissions on all tables. If 

you own this database, you need to update your permissions for all 

tables. Do this through Microsoft Access.

To compress a database:

1. Open the database you want to compress.

2. From the File menu, select Compress Database.

The database is compressed immediately; no message boxes or dialog 

boxes appear while the compression is in process. When the operation 

is finished, a message appears telling you that it was successful.

3. Click OK to finish.

Deleting an Application From the Database
The ConflictManager database should contain all applications used in your 

organization. When you discontinue use of an application, you can delete it 

from the database. You also can delete the entire contents of a database; 

for more information, see Deleting the Contents of a Database on page 52.

Warning:

Deleting an application cannot be undone. Be sure to select the correct 

application to delete.

To delete an application from the database:

1. Open the database that contains the application you want to delete.

2. From the Application menu, select Delete.

The Delete Application dialog box appears.
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3. Select the application you want to delete and click OK. Use CTRL-click 

and SHIFT-click to select multiple applications.

The applications you selected are deleted from the database.

Note:

If you have detected conflicts for applications in this database, you should 

rerun the conflict detection to clear the database of conflicts with the applications 

you deleted.

Deleting the Contents of a Database
ConflictManager provides a utility to delete all data in a database and 

recreate all the database tables. Use this utility only when you want to 

completely delete the entire contents of a database; it deletes the 

applications, their conflicts, and all rule sets and application groups. You 

also can delete a single application from the database; see Deleting an 

Application From the Database on page 51.

Warning:

Deletion of database contents cannot be undone. Be sure to select the 

correct database.

To delete the contents of a database:

1. Open the database you want to clear.

2. From the File menu, select Delete Database Contents.

A dialog box prompts you to confirm the deletion.
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3. Click the Yes button to continue.

The contents of the current database are deleted, leaving an empty 

database. When the operation is finished, a message appears telling 

you that the deletion was successful.

4. Click OK to finish.
53



3: THE CONFLICTMANAGER DATABASE
54



Chapter 4

Setting Up ConflictManager

Before you use ConflictManager to detect and resolve conflicts, you should 

define conflict settings, which determine the type of conflicts that are 

detected. Conflict settings also determine items, such as files and registry 

keys, that are excluded from conflict detection. This lets you refine the 

conflict detection so it finds only the kinds of conflicts that concern you.

You also should decide whether you want to use conflict resolution rules 

and, if so, you need to decide which predefined rule set or sets to use. If 

you are using the Enterprise Edition, you can modify the predefined rule 

sets or create your own.

In this section, learn about:

• Defining conflict settings.

• Using and defining conflict resolution rules.
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Defining Conflict Settings

Conflict settings determine the type of conflicts that are detected and the 

items, such as files and registry keys, that are excluded from the conflict 

detection. Excluding files and registry keys helps eliminate conflicts that 

don’t have a negative impact on any installation. For instance, several 

applications might install a file named readme.txt, but that generally is not 

a conflict that you need to resolve. Therefore, you could define the conflict 

settings to ignore that file during conflict detection.

You define the conflict settings in the Conflict Settings dialog box. This 

dialog box contains three tabs:

• Types. Lets you define the kinds of conflicts you want to find.

• Files/Directories. Lets you specify the directories and files to ignore 

during conflict detection. You can use wildcards to ignore all instances of 

a particular type of file.

• Registry Keys. Lets you specify the registry subtrees and individual 

keys to ignore during conflict detection.

Note:

If you change conflict settings after you have found conflicts, you must rerun 

the conflict detection to apply the changes to the current conflict database.

Defining Conflict Types
You use the Types tab of the Conflict Settings dialog box to specify the 

types of conflicts you want to find, such as warning, error, or informational 

conflicts for files or registry keys. You can also specify whether to find 

conflicts for other items, such as devices, .INI files, shortcuts, and more.

To define conflict types:

1. From the Setup menu, select Conflict Settings.

The Conflict Settings dialog box appears, with the Types tab active.
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2. In the File Conflicts drop-down list, select an option to define the type 

of file conflicts you want to find.

• Normal file conflicts (warnings and errors only). Find warning 

and error conflicts. Warnings occur when files with the same name 

and different file information are installed in different directories. 

Errors occur when files with the same name and different file 

information are installed in the same directory.

• Normal conflicts plus informational. Find information conflicts in 

addition to warnings and errors. An information conflict occurs when 

two or more installation packages install a file with identical file 

information, either to the same directory or to different directories. 

Finding information conflicts slows the conflict detection process.

• Do not run file conflicts. Run the conflict detection without looking 

for file conflicts. You might select this option when you want to check 

for a specific type of conflict other than file conflicts.

3. If file has version information, ignore date/time for conflict 

analysis. Mark this checkbox to ignore date and time differences 

between files that have the same version and size. Clear this checkbox 
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if you want the conflict detection to find date and time differences when 

all other file information is the same.

4. In the Registry Conflicts drop-down list, select an option to define the 

type of registry conflicts you want to find.

• Normal Registry conflicts (warnings and errors only). Find 

registry keys and named values that are set differently by more than 

one application.

• Normal Registry plus informational conflicts. Find all registry 

keys and named values that are set by more than one application, 

whether they are set to the same or different values.

• Do not run registry conflicts. Run the conflict detection without 

looking for registry conflicts. You might select this option when you 

want to check for file conflicts only, or for a specific type of conflict 

other than registry conflicts.

5. Mark any of the following checkboxes to find additional conflicts.

Note:

These checkboxes are not often used because the types of conflicts listed 

below are rarely found and cannot be resolved. In addition, leaving these 

checkboxes unmarked speeds conflict detection.

• Autoexec.bat. Find modifications to Autoexec.bat that are made by 

more than one application.

• Config.sys. Find modifications to Config.sys that are made by more 

than one application.

• ODBC. Find Open Data Base Connectivity data sources that are 

configured differently by applications.

• NT Services. Find Windows NT services that are installed by more 

than one application.

• Devices. Find device drivers that are installed in Win.ini by more 

than one application.

• INI Files. Find changes to .INI files that are made by more than one 

application.

• Shortcuts. Find shortcuts that are installed by more than one 

application.

• Path Additions. Find changes to the PATH variable that are made 

by more than one application.

6. Click OK to close the dialog box, or click the Files/Directories or 

Registry Keys tab to define additional settings. See Excluding Files and 

Directories on page 59 or Excluding Registry Keys on page 62.
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Excluding Files and Directories
You use the Files/Directories tab of the Conflict Settings dialog box to 

specify files and directories to ignore during conflict detection. For 

example, readme.txt is installed by many applications, but generally is not 

a conflict that you need to resolve. Another example of a file to ignore is 

MSCREATE.DIR, entered as a wildcard under All Directories. As you use 

ConflictManager, you might find additional files and directories that can be 

ignored. You can add them to the Conflict Settings at any time.

The upper two list boxes show the directories and files available to your 

computer, including your local drives, mapped drives, and local network. 

The bottom two list boxes represent the directory structure and files that 

will be ignored during conflict detection.
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The upper left list box shows a composite view of all directories created on 

the destination computer by all application installations in the database. 

Some installed files or directories might be located in the Windows 

directory or the Program Files directory. When you select a directory in the 

upper left list box, the upper right list box shows the files contained in that 

directory.

Note:

The upper left list box shows information for ALL applications, even if you 

have a group selected in the Groups pane. (Groups are available in the Enterprise 

Edition only.)

The two lower list boxes contain the exclusion list, which represents the 

directory trees and files to ignore during conflict detection. You can add an 

entire directory tree to the exclusion list, or you can add individual files. 

When you add a directory, you can specify a wildcard, such as *.txt, to 

ignore only those files in the directory that match the wildcard.

To specify directories or wildcards to ignore during conflict 

detection:

1. From the Setup menu, select Conflict Settings.

The Conflict Settings dialog box appears.

2. Click the Files/Directories tab.

3. In the upper left list box, navigate to a directory that you want to 

ignore, then click the Add Tree button.

The Add Wildcard dialog box appears.

4. In the Add Wildcard dialog box, you can choose to ignore all files in the 

directory or only those files that match a wildcard. You also decide 

whether to apply your choice to only the directory you selected or to all 

its subdirectories also.

• To ignore all files in the directory, leave the Wildcard field blank.

• To ignore just certain files in the directory, enter a wildcard in the 

Wildcard field, such as *.txt.
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• To apply your choice to all subdirectories of the directory also, mark 

the Include Sub-directories checkbox.

5. Click OK in the Add Wildcard dialog box.

The Conflict Settings dialog box reappears with the directory added to 

the lower left list box. The lower right list box shows what file or files 

should be ignored in that directory, and whether they are applied to 

subdirectories also. If you entered a wildcard, it appears in the 

Filename column. If you left the Wildcard field blank, a single 

asterisk character (*) appears in the Filename column to represent all 

files.

6. When you are finished selecting directories to exclude, click OK to close 

the dialog box, or click the Types or Registry Keys tab to define 

additional settings. See Defining Conflict Types on page 56 or Excluding 

Registry Keys on page 62.

To specify files to ignore during conflict detection:

1. From the Setup menu, select Conflict Settings.

The Conflict Settings dialog box appears.

2. Click the Files/Directories tab.

3. In the upper left list box, navigate to a directory that contains a file you 

want to ignore.

4. In the upper right list box, click on the file name and then click the Add 

File button. Use the CTRL or SHIFT keys to select multiple files.

The file is added to the lower right list box, and the corresponding 

directory structure appears in the lower left list box.

5. When you are finished selecting files to exclude, click OK to close the 

dialog box, or click the Types or Registry Keys tab to define additional 

settings. See Defining Conflict Types on page 56 or Excluding Registry 

Keys on page 62.

Note:

If you delete a file from the lower right list box and it empties the directory, 

the directory structure still displays but disappears after you close the Conflict 

Settings dialog box.
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Excluding Registry Keys
You use the Registry Keys tab of the Conflict Settings dialog box to specify 

registry key subtrees and registry values to ignore during conflict 

detection. As you use ConflictManager, you might find additional registry 

keys that can be ignored. You can add them to the Conflict Settings at any 

time.

The upper two list boxes show registry keys and values for all applications 

in the database. The lower two list boxes represent the keys and values to 

be ignored during conflict detection. The left two list boxes show key 

structure, and the right two list boxes show values.
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To specify registry keys to ignore during conflict detection:

1. From the Setup menu, select Conflict Settings.

The Conflict Settings dialog box appears.

2. Click the Registry Keys tab.

3. In the upper left list box, navigate to a registry key or value that you 

want to ignore.

• To ignore an entire tree, select the key in the upper left list box and 

click the Add Tree button.

• To ignore an individual value, select the value in the upper right list 

box and click the Add Value button.

The registry key subtree or value is added to the corresponding lower 

list box.

4. When you are finished selecting registry keys to exclude, click OK to 

close the dialog box, or click the Types or Files/Directories tab to define 

additional settings. See Defining Conflict Types on page 56 or Excluding 

Files and Directories on page 59.

Note:

If you delete a value from the lower right list box and it makes the key 

empty, the corresponding registry key subtree still shows temporarily but 

disappears after you close the Conflict Settings dialog box.
63



4: SETTING UP CONFLICTMANAGER
Using Conflict Resolution Rules

ConflictManager’s resolution rules let you resolve conflicts automatically. 

Using resolution rules saves time, reduces errors, and provides consistency 

in conflict resolution.

ConflictManager contains four predefined rule sets. After you find conflicts, 

you use the Resolve With Rules menu command to resolve the conflicts 

according to the rule set you choose. The majority of conflicts can be 

resolved this way. See Resolving File Conflicts Automatically With Rules on 

page 91. You might find some conflicts that cannot be resolved with rules; 

if so, use the Resolve wizard to resolve those few conflicts individually.

If you have the Enterprise Edition, you can modify the predefined rule sets 

or create your own to reflect your company’s standards. Before you create 

your own rule sets, experiment with the predefined rules. You might find 

that the predefined rule sets resolve your conflicts satisfactorily and you 

don’t have to create your own. See About the Predefined Rule Sets on 

page 65.

Rule sets are stored with the database, therefore, if you use multiple 

ConflictManager databases, you must set up rule sets separately in each 

one. The predefined rule sets are added automatically to each new 

ConflictManager database you create. If you open a database created in a 

previous version of ConflictManager, it is updated and the predefined rule 

sets are added automatically.

About Conflict Resolution Rules
ConflictManager rule sets help you resolve conflicts automatically. A rule 

set is simply a collection of rules. A rule consists of one or more actions, 

one or more conditions, and one or more sort options.

• An action states how a conflict will be resolved.

• A condition determines the criteria that a conflict must meet in order for 

the action to be performed. For example, if you select the condition 

version differs, the Resolve with Rules process performs the action 

only on conflicts caused by files having different version numbers.

• A sort option determines how conflicting files are sorted and thus which 

one is used to resolve the conflict. For example, if you sort by version 

number, then the file with the highest version number is used.

See Guidelines for Resolving File Conflicts on page 31 for recommendations 

on when to use each rule action.
64



USING CONFLICT RESOLUTION RULES
How Conflict Resolution Rules Are Applied

Conflict resolution rules are applied in the order they appear from top to 

bottom in the list of rules in the Conflict Resolution Rules dialog box.

When a rule has more than one condition, only conflicts that meet all of the 

conditions have the rule applied to them. For example, if you specify the 

two conditions File is executable and Version differs, the rule only 

applies to conflicts that meet both conditions.

About the Predefined Rule Sets
ConflictManager contains the following predefined rule sets:

• Conservative. The conservative rule set changes as little as possible to 

get the application to work. It replaces files in the active application only 

with the corresponding files in the conflicting applications. An active 

application file is changed only if its version and date are lower than that 

of the conflicting file, and only if the manufacturer is the same as in the 

conflicting file.

The conservative rule set ignores conflicts that cannot be resolved in a 

conservative way. This can result in more conflicts for you to resolve 

individually.

• Aggressive (all operating systems) and Aggressive (Windows 98 

SE/2000/ME only). The aggressive rule sets change more files in the 

active application and can change files in other conflicting applications. 

They replace all conflicting files with the most recent version; this 

means that files in the other conflicting applications might be replaced. 

Do this only when you have access to the other applications’ source files 

and can recompile the other applications.

The aggressive rule sets also attempt to isolate any files that are shared 

by multiple applications. The aggressive rules for all operating systems 

use application paths to isolate files; the aggressive rules for Windows 

98 SE/2000/Me use isolated components.

The aggressive rule sets can resolve more conflicts than the 

conservative rules. The drawback is that you must export and retest any 

other applications that are changed.

• Restore original conflicts. This is actually an empty rule set that 

provides an easy way to undo an application’s conflict resolutions and 

revert to its original file versions and locations. When you resolve with 

rules, the first thing any rule set does is revert all previous conflict 

resolutions for the selected application. Because this rule set contains 

no rules, that’s all it does.
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Creating a New Rule Set
If the predefined rule sets do not meet your needs, and you don’t want to 

modify a predefined rule set, you can create a new rule set based on your 

organization’s standards.

Enterprise Edition only

The ability to modify and create rule sets is available in the Enterprise Edition 

only.

To create a new rule set:

1. From the Setup menu, select Conflict Resolution Rules.

The Conflict Resolution Rules dialog box appears.

2. From the Rule Set Name drop-down list, select <new>.

The Enter Rule Set Name dialog box opens.

3. In the Rule Set Name field, enter a name for this rule set and click 

OK.

4. In the Conflict Resolution Rules dialog box, click the Add button to add 

the first rule for this rule set.
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The Rules wizard starts and opens the Name dialog box.

5. Enter a name for this rule and click the Next button.

The Actions dialog box appears.
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6. In the Which action(s) do you want to perform list, mark the 

checkbox next to the action or actions you want to perform. Mark the 

checkboxes in the order you want the actions to be performed.

A description of each action appears in the Rule description list.

7. If a description contains underlined text, you can click the underlined 

text to open a Rule Detail Settings dialog box. There you can select a 

value for the underlined text.

8. Click the Next button.

The Conditions dialog box appears.

9. In the Which condition(s) do you want to check list, mark the 

checkbox next to each condition you want to check, in the order you 

want to check them.

As you mark checkboxes, a description of each condition appears in the 

Rule description list.

10. If a description contains underlined text, you can click the underlined 

text to open a Rule Detail Settings dialog box. There you can select a 

value for the underlined text.

11.Click the Next button.

The Sort Order dialog box appears.
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12. In the Which sort(s) do you want to perform list, mark the 

checkbox next to each sort option you want to perform, in the order 

you want to perform them (you can change the sort order later).

As you mark checkboxes, a description of each sort option appears in 

the Rule description list.

13. To rearrange the sort order, click on a sort option in the Rule 

description list, then click the Move Up or Move Down button.

14. Click the Finish button.

The Conflict Resolution Rules dialog box reappears, with your rules 

displayed in the Rule description list. You cannot edit the rules from 

this dialog box, however, you can click any underlined text to set a 

value.

15. Click the OK button to save this rule set, or continue to add and edit 

rules.
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Editing a Rule Set
You can edit or delete existing rule sets. You also can edit and delete rules 

within a rule set, and change the order in which rules are applied.

Enterprise Edition only

The ability to edit rule sets is available in the Enterprise Edition only.

To edit a rule set:

1. From the Setup menu, select Conflict Resolution Rules.

The Conflict Resolution Rules dialog box appears.

2. From the Rule Set Name drop-down list, select the rule set you want 

to edit.

You can edit the rule set in any of the following ways:

• To add a new rule to the rule set, click the Add button and step 

through the Rules wizard. See Creating a New Rule Set on page 66.

• To edit a rule, click the rule in the rules list and click the Details 

button. This starts the Rules wizard, which you can step through to 

change the rule name or change any of the actions, conditions, and 

sort options.

• To delete a rule, click the rule in the rules list and click the Delete 

button.

• To change the order of the rules, click a rule in the rules list and click 

the Move Up or Move Down button.

3. When you are finished editing the rule set, click OK to save your 

changes.
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Importing and Grouping 
Applications

Once you have defined your conflict settings and resolution rules, you are 

ready to import applications in to the ConflictManager database. Typically, 

you use the Distribution Wizard to distribute your repackaged applications 

to the ConflictManager share point or to a network directory. Then, you 

import the applications to ConflictManager.

The Enterprise Edition of ConflictManager lets you group applications, 

which lets you reduce the number of conflicts you view at one time. In a 

large organization, for example, you might not be concerned about 

resolving conflicts between applications that are installed on computers in 

different departments. By creating a group for each department, you can 

view conflicts for one department at a time.

In this section, learn about:

• Importing applications into the database.

• Grouping applications.
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Importing Applications Into the Database

Before you can detect conflicts, you must import application installations 

into the ConflictManager database. These can be installations that you 

repackaged in Wise Package Studio, or new installations that you built in 

the Wise Installation System or Wise for Windows Installer.

You can import an application into the database in the following ways:

• Import from the ConflictManager share point. This is the 

recommended way to distribute and import applications. You use the 

Distribution Wizard to distribute an application installation to the 

ConflictManager share point. Then, you open ConflictManager and 

import the application. If you are using the Enterprise Edition, you can 

use the Auto Import Service to import applications automatically. See 

Importing From the ConflictManager Share Point on page 73.

• Import from any network or local drive. You can import an 

application from any drive. Use this method when you distribute 

application installations to a network drive, or when you have developed 

the installation and saved it to a local or network drive. See Importing 

From a Network or Local Drive on page 78.

Note:

Do not import an application from a CD. If you do, you will not be able to 

export the application after resolving its conflicts, because you will not have 

access to its source files and you cannot write to a CD.

• Distribute directly to the ConflictManager database. This method 

is provided primarily for organizations that want to use ConflictManager 

as a reporting tool. You use the Distribution Wizard to distribute an 

application installation directly to the ConflictManager database. The 

next time you open the database in ConflictManager, the application 

automatically appears in the database.

Note:

Distributing directly to the ConflictManager database does not copy any 

files, so you cannot recompile the application after resolving its conflicts.
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Importing From the ConflictManager Share Point
When you use the Distribution Wizard to distribute an application to the 

ConflictManager share point, the installation is copied to the directory 

designated as the share point during the Wise Package Studio installation. 

You can import installations from the share point in any of three ways:

• When you start ConflictManager, it searches the share point for 

applications that have not been imported. If it finds any, it displays the 

Import from Share Point dialog box automatically. If you select one or 

more applications and click OK, the applications are imported. If you 

click Cancel, ConflictManager opens without importing the applications.

• If you do not import an application when you start ConflictManager, or if 

an application is distributed to the share point after you start 

ConflictManager, you can use the Import from Share Point command on 

the Application menu.

• Use the Auto Import Service to import applications automatically. To use 

this method, the Auto Import Service must be installed on the server, 

and you must distribute the applications to the ConflictManager share 

point with a Workbench task that contains command line variables for 

the Application and Package names. See Running the Auto Import 

Service on page 76.

Enterprise Edition only

The Auto Import Service is available in the Enterprise Edition only.

Note:

When you use either Windows Installer Editor or WiseScript Editor to add 

files to an application that has already been distributed to the share point, a prompt 

appears asking if you want to add the new files to the share point. If you do so, the 

.QUE file for that application is reset and, the next time you start ConflictManager, 

you will be asked to import the application.

To import an application from the ConflictManager share point:

1. Display the Import from Share Point dialog box in either of two ways:

• In ConflictManager, select Import from Share Point from the 

Application menu.

OR

• Start ConflictManager after distributing installations to the 

ConflictManager share point. The Import from Share Point dialog box 

appears automatically.
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The Import from Share Point dialog box lists the applications that are 

available to be imported.

2. Select the applications you want to import and click OK. Use CTRL-click 

and SHIFT-click to select multiple applications.

The Import Application dialog box appears.

3. Complete the Import Application dialog box:

• WSE/MSI/WSI File. Specify the pathname to the installation file 

you want to import.
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• Application Name. To create a new application, enter the name 

you want to use for this application in the ConflictManager database. 

If the application you’re adding is a package of an existing 

application, select it from the drop-down list.

• Package Name. The package name, such as Full Install 3.0 or Basic 

Install 3.0, distinguishes this installation from others with the same 

application name. To create a new package, enter the name in this 

field. To replace an existing package, select a package from the 

drop-down list. See How Do Applications and Packages Differ? on 

page 14.

• Setup Executable. This option is used only with .WSE files created 

in version 7.03 or lower of InstallMaster, any version of InstallMaker 

and InstallBuilder, or any version of the Wise Installation System - 

Standard Edition. Specify the compiled .EXE file for this installation. 

If ConflictManager can’t find the necessary file information stored in 

the installation file or in the application’s source path, it extracts the 

necessary files from the setup executable to a temporary directory, 

then collects the data and removes the temporary directory and its 

contents.

• Transform File. When you import a .WSI or .MSI, you can specify a 

transform to be applied to the application before it is imported to 

ConflictManager. That way, any files or registry keys that are added 

by the transform can be included in conflict detection.

• Use Transactions for Import. Mark this checkbox to import 

installation resources as transactions instead of importing them 

individually. This speeds the import, but can lock database records 

temporarily during the update. Use this option if you are the only 

person importing applications, and if you are only importing one 

application at a time. If multiple people are importing applications at 

one time, or if you are importing multiple applications, do not mark 

this checkbox.

4. Click OK to import the application into the database.

5. If you selected multiple applications, the Import Application dialog box 

appears for the next application. Continue to enter the Import 

Application information for each application.
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Running the Auto Import Service

Enterprise Edition only

The Auto Import Service is available in the Enterprise Edition only.

The Auto Import Service can import applications into the ConflictManager 

database automatically. In order to use this service:

• The Auto Import Service must be installed on the server on which the 

ConflictManager database resides. The service is installed during a 

ConflictManager server installation.

• The data source must be set up on the server.

• The applications to be imported must have been placed in the share 

point by the Distribution Wizard, and the Distribution Wizard must have 

been launched as a task from the Projects tab. The Application and 

Package name variables must be specified in the task’s command line 

options.

The service starts when someone boots the server. It periodically searches 

the share point for .QUE files, which represent distributed applications. 

When it finds a .QUE file, the service automatically imports that application 

into the ConflictManager database and then removes the .QUE file. The 

next time you open the ConflictManager database, it includes that 

application.

The Auto Import Service can import to one ConflictManager database only. 

If you want to use multiple ConflictManager databases, install each one on 

its own server, and perform a ConflictManager server installation on each 

server.

While the Auto Import Service is running, a ConflictManager Auto Import 

Service task appears on the server’s taskbar. Click the task to view the 

status of the service.
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The ConflictManager Auto Import Service dialog box shows the imports 

that have been attempted and whether they were successful. The Failed 

Script Count field displays the number of import attempts that have failed. 

Failed imports are retried the next time the service is started, or you can 

click the Retry button.

To retry failed imports:

• Failed imports are retried automatically the next time the service is shut 

down and restarted.

OR

• Click the Retry button on the ConflictManager Auto Import Service 

dialog box.

To shut down the service:

1. Display the ConflictManager Auto Import Service dialog box.

2. Click the Exit button.

To start the service:

1. On the server, from the Windows Start menu, select the Programs 

folder, then the StartUp folder.

2. Click the Auto Import Service icon.

The service starts and the ConflictManager Auto Import Service dialog 

box appears.
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Importing From a Network or Local Drive
You can import an application installation from any network or local 

directory you can access. Use this method when you use the Network 

distribution method in the Distribution Wizard, or when the installation is 

saved on a local or network drive.

Note:

Do not import an application from a CD. If you do, you will not be able to 

export the application after resolving its conflicts, because you will not have access 

to its source files and you cannot write to a CD.

To import an installation from a network or local drive:

1. From the Application menu, select Import.

The Import Application dialog box appears.

2. Complete the Import Application dialog box:

• WSE/MSI/WSI File. Specify the pathname to the installation file 

you want to import.

• Application Name. To create a new application, enter the name 

you want to use for this application in the ConflictManager database. 

If the application you’re adding is a package of an existing 

application, select it from the drop-down list.

• Package Name. The package name, such as Full Install 3.0 or Basic 

Install 3.0, distinguishes this installation from others with the same 

application name. To create a new package, enter the name in this 
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field. To replace an existing package, select a package from the 

drop-down list. See How Do Applications and Packages Differ? on 

page 14.

• Setup Executable. This option is used only with .WSE files created 

in version 7.03 or lower of InstallMaster, any version of InstallMaker 

and InstallBuilder, or any version of the Wise Installation System - 

Standard Edition. Specify the compiled .EXE file for this installation. 

If ConflictManager can’t find the necessary file information stored in 

the installation file or in the application’s source path, it extracts the 

necessary files from the setup executable to a temporary directory, 

then collects the data and removes the temporary directory and its 

contents.

• Transform File. When you import a .WSI or .MSI, you can specify a 

transform to be applied to the application before it is imported to 

ConflictManager. That way, any files or registry keys that are added 

by the transform can be included in conflict detection.

• Use Transactions for Import. Mark this checkbox to import 

installation resources as transactions instead of importing them 

individually. This speeds the import, but can lock database records 

temporarily during the update. Use this option if you are the only 

person importing applications. If multiple people are importing 

applications at one time, do not mark this checkbox.

3. Click OK to import the application into the database.

If the database already contains one or more applications, the Detect 

Conflicts dialog box appears, with the new application highlighted. You 

can detect conflicts now (see Detecting Conflicts on page 84) or click 

the Cancel button to skip conflict detection.

Note:

If you get a message that some files cannot be found, the paths in the 

installation might be absolute. Avoid this problem by using the Distribution Wizard 

to distribute to the ConflictManager share point or to the network, instead of saving 

to the network drive.
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Grouping Applications

You can use groups to reduce the number of conflicts you view at one time. 

A group consists of a subset of the applications in your database. When 

you retrieve conflicts for a group, you only display conflicts between the 

applications in the group.

Enterprise Edition only

Groups are available in the Enterprise Edition only.

A group can represent a functional area within your company, a company 

location, or any other entity that uses a subset of your applications. Groups 

can have one level of subgroups, which might represent departments 

within a location, or locations within states. A parent group always contains 

all the applications in all its subgroups.

For example, you might create a group for each department in your 

organization. Your Accounting and Engineering departments never use the 

same applications, so you put them in separate groups. Then, you can 

retrieve conflicts for Engineering alone, because it doesn’t matter whether 

their applications conflict with those of any other department.

See Creating and Editing Application Groups and Retrieving Conflicts for a 

Group on page 88.

Creating and Editing Application Groups
Use the Groups pane to create and edit groups. You can set up groups and 

subgroups, add applications to groups, and delete applications from 

groups. To show the Groups pane, select Groups from the View menu.

Enterprise Edition only

Groups are available in the Enterprise Edition only.

When you detect conflicts for a group, you only find conflicts between the 

applications in that group. Therefore, when you create a group, be sure to 

add all the applications you want to check for conflicts. When you add an 

application to a subgroup, that application is added to the parent group as 

well.

Tip:

The right-click menu gives you quick access to most of the tasks that you can 

accomplish in the Groups pane.
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To create an application group:

1. You can start to create application groups in two ways:

• Select Application Groups from the Setup menu.

OR

• On the Groups pane, click the Configure button.

The Edit Groups dialog box appears.

2. Click the New Group button.

The New Group dialog box appears.

3. In the Group Name field, enter a name for the new group.

4. If this is a subgroup, select its parent group from the Parent Name 

drop-down list.

5. Click OK to close the New Group dialog box.

6. In the Applications not in Group list, select all the applications you 

want to include in this group and click the <<Move button.
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You can select more than one application at a time. To move just one 

application, double-click it. To remove an application from the 

Applications in Group list, select it and click the Move>> button.

7. When you are finished defining the new group, click OK.

To edit an application group:

1. You can begin to create application groups in two ways:

• Select Application Groups from the Setup menu.

OR

• On the Groups pane, click the Configure button.

The Edit Groups dialog box appears.

2. From the Groups Defined drop-down list, select the group you want to 

edit.

3. Edit the group in any of the following ways.

• Use the two Move buttons to move applications back and forth 

between the Applications in Group and Applications not in 

Group lists.

• Select a different parent group from the Parent drop-down list.

• Delete the group by clicking the Delete Group button.

4. When you are finished editing the group, click OK.

To add an application to a group by dragging:

1. If necessary, show the Groups pane by selecting Groups from the View 

menu.

2. In the Groups pane, select the group containing the application you 

want to add. This usually is All Applications.

3. If necessary, expand the All Applications tree in the left pane of the 

Application Explorer.

4. Drag the application or package over a group name in the Groups pane.

• You can drag the entire application from the right pane of the 

Application Explorer.

OR

• You can click the application name in the left pane of the Application 

Explorer, and drag a package from the right pane.

Use CTRL-click and SHIFT-click to select multiple applications or 

packages. 

5. The application or package is added to the group. If you dragged the 

application to a subgroup, it is added to the parent group also.
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Finding and Resolving 
Conflicts

As soon as you have at least two applications in your database, you can 

begin to find and resolve conflicts. ConflictManager detects conflicts by 

comparing the files each application installs. When it finds a conflict, it 

creates records in the database. To see the conflicts ConflictManager finds 

for a specific application, you retrieve them. To resolve the conflicts, you 

use either the Resolve wizard to resolve conflicts one by one, or the 

Resolve with Rules menu command to resolve as many conflicts as possible 

based on resolution rules you have chosen. Finally, you export the changes 

to the original installation file and recompile it. The conflict-free application 

is ready for deployment to your end users.

In this section, learn how to:

• Detect conflicts.

• Review conflicts.

• Resolve conflicts.

• Export applications after resolving conflicts.
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Detecting Conflicts

After importing the application installations you use into ConflictManager, 

you can find conflicts by selecting Detect from the Conflicts menu. You 

choose one or more applications for which to find conflicts, then start the 

detection process, which populates the database with conflict information 

for those applications you chose.

The ConflictManager database contains the combined results of all the 

detection processes you have performed. However, repeating the detection 

process for an application overwrites all previous conflict records for that 

application.

To see the conflicts that ConflictManager finds, you use the Retrieve button 

in the upper left pane of the Conflict List. You can only retrieve conflicts for 

one application at a time.

To detect conflicts:

1. From the Conflicts menu, select Detect.

The Detect Conflicts dialog box appears.
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2. In the Detect Conflicts dialog box, select one or more applications for 

which you want to find conflicts. You can use SHIFT-click or CTRL-click to 

select multiple applications.

• Conflicts are found only between the application or applications you 

select and all other applications in the database. For example, if you 

have Microsoft Word and Lotus Notes in the database, and you 

choose to find conflicts for Word, any item for Word that conflicts 

with Notes (or some other application) will be found, but no items 

for Notes will be found.

• Select All Applications to find every record in every application 

that conflicts with any other application.

You can change the conflict settings from this dialog box. Click the 

Settings button and define the settings as described in Defining Conflict 

Settings on page 56.

3. Click OK to begin the conflict detection.

Depending on the number of applications in the database and the speed of 

your server, conflict detection can take a few minutes to run. While the 

conflict detection is running, you can see its status on the status bar in the 

lower right of the window. You can continue to use ConflictManager while 

conflict detection is in progress. When conflict detection is complete, the 

status bar displays “Idle.”

You cannot exit the program while conflict detection is running; you must 

stop the conflict detection first.

To stop conflict detection:

If you need to close ConflictManager, but conflict detection is running, you 

must stop the conflict detection first. To do so, select Stop from the 

Conflicts menu. The status in the status bar returns to “Idle”.

Stopping conflict detection before it finishes can leave partial records in the 

database. If you must stop conflict detection, be sure to rerun it later. You 

cannot revert the database to its previous state, unless you have a current 

backup copy.
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Reviewing Conflicts

In order to view conflicts for a particular application, you must retrieve 

them in the Conflict List. To do this, you specify an application, a package, 

and the type of conflict to display, then click the Retrieve button. The right 

pane of the Conflict List shows all conflicts meeting those criteria. Clicking 

a conflict in the Conflict List lets you view further information about that 

conflict in the Application Explorer. See Retrieving Conflicts in the Conflict 

List.

You can also review conflicts by printing one or more of the conflict reports. 

These reports, which you access from the Reports menu, provide conflict 

information in varying formats. For more information about reports, see 

Running Conflict Reports on page 105.

You can view properties for any item in the right pane of the Application 

Explorer by displaying a Properties dialog box. The Properties dialog box 

shows additional information about the item. See Viewing Properties on 

page 89.

If you are using the Enterprise Edition, you can use application groups to 

narrow the scope of the conflicts you retrieve. This lets you see the 

conflicts for just a subset of the applications in the database, rather than 

all applications. See Retrieving Conflicts for a Group on page 88.

Retrieving Conflicts in the Conflict List
The Conflict List lets you select an application package and view the files 

and system modifications in that package that conflict with other 

applications. Typically, you select an application, a package, and the type 

of conflict to display. When you click the Retrieve button, the Conflict List 

displays the conflicts between the selected, or active, application and all 

other applications in the database.

To retrieve conflicts:

1. In the left pane of the Conflict List, select an application from the 

Application drop-down list.

2. In the Package drop-down list, select the application package for 

which you want to display conflicts.
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3. In the Conflict Type drop-down list, select the type of conflicts you 

want to display: All, Files, Registry, or Other.

4. Mark the Errors checkbox to list error conflicts (items that almost 

certainly will cause problems); clear the checkbox to exclude errors.

5. Mark the Warnings checkbox to list warning conflicts (items that 

probably will not cause problems); clear the checkbox to exclude 

warnings.

6. Click the Retrieve button.

All conflicts that meet the criteria you entered are displayed in the right 

pane of the Conflict List. For a description of the types of conflicts 

possible, see Types of Conflicts on page 29.

Note:

The types of conflicts that actually display depend on your Conflict Settings. 

For example, if your Conflict Settings are set to detect file conflicts only, then 

registry conflicts will not appear even if you select Registry in the Conflict Type 

field.

Once you have displayed the conflicts, you can perform the following 

actions.

• Click any item in the Conflict List to display the same item in the 

Application Explorer. This lets you see where in the directory structure 

the item is located.

• Double-click an item in the Conflict List to display the same item in the 

Application Explorer and display the names of all conflicting application 

packages.
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Clearing the Conflict Display
To clear the Conflict List and Application Explorer of the current conflicts, 

select Refresh from the View menu. This does not delete the conflicts from 

the database; it simply clears the display. It also rereads application data, 

which can be useful if the Auto Import Service, or another user, has 

imported applications into the database since you started this 

ConflictManager session.

Retrieving Conflicts for a Group

Enterprise Edition only

Groups are available in the Enterprise Edition only.

You can use groups to reduce the number of conflicts you view at one time. 

A group consists of a subset of the applications in your database. When 

you retrieve conflicts for a group, you only display conflicts between the 

applications in the group. See Grouping Applications on page 80 for 

information on setting up groups.

To view the conflicts between applications in a group:

1. If necessary, show the Groups pane by selecting Groups from the View 

menu.

2. Select a group name in the Groups pane.

3. In the left pane of the Conflict List, select an application from the 

Application drop-down list. The Application drop-down list contains 

only the applications in the currently selected group.

4. Select other options for retrieving conflicts:

• In the left pane of the Conflict List, select an application from the 

Application drop-down list.

• In the Package drop-down list, select the application package for 

which you want to display conflicts.

• In the Conflict Type drop-down list, select the type of conflicts you 

want to display: All, Files, Registry, or Other.

• Mark the Errors checkbox to list error conflicts; clear the checkbox 

to exclude errors.

• Mark the Warnings checkbox to list warning conflicts; clear the 

checkbox to exclude warnings.

5. Click the Retrieve button.
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All the conflicts between the application you selected and the other 

applications in the group are shown in the right pane of the Conflict List.

Viewing Properties
You can view properties for any item in the right pane of the Application 

Explorer by displaying a Properties dialog box. The Properties dialog box 

shows additional information about the item. This information differs 

depending on the type of item you select; it can include the following:

File details

Component details

Registry key settings

Autoexec.bat settings

Config.sys settings

ODBC drivers

ODBC data sources

Service settings

Device settings

.INI file settings

Shortcut (Icon) details

Path settings

Conflicts for all item types

Caution:

You can change the information displayed in the Properties dialog boxes, but 

it is not recommended except for Registry keys, and then only if you are the 

developer of the application and you have extensive knowledge of how Windows 

operates. See Resolving Registry Key Conflicts on page 97.

Changing property information incorrectly can damage the installation.

To view properties:

1. If you want to retrieve conflicts for a group, click a group in the Groups 

pane (Enterprise Edition only).

2. Select options for retrieving conflicts:

• In the left pane of the Conflict List, select an application from the 

Application drop-down list.

• In the Package drop-down list, select the application package for 

which you want to display conflicts.

• In the Conflict Type drop-down list, select the type of conflicts you 

want to display: All, Files, Registry, or Other.

• Mark the Errors checkbox to list error conflicts; clear the checkbox 

to exclude errors.
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• Mark the Warnings checkbox to list warning conflicts; clear the 

checkbox to exclude warnings.

3. Click the Retrieve button to display conflicts.

4. Click any item in the right pane of the Conflict List to display the same 

item in the Application Explorer.

5. In the right pane of the Application Explorer, double-click the item for 

which you want to view properties.

A Properties dialog box appears. The information in the dialog box 

differs depending on the type of item you selected.
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Resolving Conflicts

Resolving a conflict involves looking at each file that has a conflict and 

choosing which version is installed on the destination computer. You can 

also choose to change the location of conflicting files so that each 

application can use its respective version of the file. ConflictManager 

provides two menu commands to resolve conflicts for a particular 

application:

• Resolve with Rules. This command uses conflict resolution rules to 

resolve conflicts automatically. See Resolving File Conflicts 

Automatically With Rules.

• Resolve. This command runs the Resolve wizard, which lets you review 

and resolve file conflicts one at a time. See Resolving File Conflicts 

Individually With the Resolve Wizard on page 92.

The Resolve and Resolve with Rules commands resolve file conflicts only. 

To resolve registry key value conflicts, you must use the Properties dialog 

box that is accessible from the Application Explorer. See Resolving Registry 

Key Conflicts on page 97.

Caution:

Resolve registry key conflicts only if you are the developer of the application 

and you have extensive knowledge of how Windows operates. Changing registry 

information incorrectly can damage the installation. Changing information in 

HKEY_CLASSES_ROOT is never recommended.

Resolving File Conflicts Automatically With Rules
You can use ConflictManager’s resolution rules to resolve the majority of 

conflicts automatically. This is the fastest way to resolve conflicts. You 

specify the rule set to use and the application for which to resolve conflicts, 

and the conflicts are resolved according to the rules. Resolving with rules 

always deletes all previous conflict resolutions for the selected application.

When the conflict resolution is finished, retrieve conflicts for that 

application. If conflicts are listed, they could not be resolved automatically. 

Use one of the manual methods to resolve the remaining conflicts. See 

Resolving File Conflicts Individually With the Resolve Wizard on page 92 

and Resolving Registry Key Conflicts on page 97.
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To resolve conflicts automatically:

1. From the Conflicts menu, select Resolve with Rules.

The Resolve with Rules dialog box appears.

2. Specify the rule set you want to use and the application for which you 

want to resolve conflicts.

• Rule Set Name. Select the rule set you want to use.

• Application. Select the application for which you want to resolve 

conflicts.

• Package. Select the package for which you want to resolve 

conflicts.

3. Click OK.

A Resolving Conflicts dialog appears, and conflicts are resolved based 

on the rule set specified. If there are only a few conflicts to resolve, the 

dialog box appears only briefly.

Resolving File Conflicts Individually With the 
Resolve Wizard

The Resolve wizard walks you through a series of steps that let you quickly 

resolve file conflicts. Use it to resolve file conflicts individually without 

using resolution rules. You can also use the Resolve wizard to resolve 

conflicts that cannot be resolved automatically with rules. For 

recommendations on how to resolve various types of conflicts, see 

Guidelines for Resolving File Conflicts on page 31.
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To resolve conflicts with the Resolve wizard:

1. From the Conflicts menu, select Resolve.

The Welcome dialog box appears.

2. In the Application drop-down list, select the application for which you 

want to resolve conflicts.

3. In the Package drop-down list, select which package of the selected 

application you want to resolve conflicts for.

4. In the Isolation method drop-down list, select an option to allow the 

wizard to move executable files from the System directory. This 

activates the Move button on the File Conflicts and File Conflicts in 

Registry dialog boxes.

• Do not move files. Do not allow file isolation.

• Isolated Components (Windows 98 SE/2000/Me). Isolate files 

by using Windows Installer isolated components. The isolation of the 

files is then managed by the operating system. This is supported by 

Windows 98 SE, Windows 2000, and Windows Me only.

• Application Paths. Isolate files by moving them out of the System 

directory and into a private directory in the main application path. 

This is supported by all Windows operating systems.

5. Path. If you select the Application Paths isolation method, enter the 

directory name for the private directory that can contain the executable 
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files. Enter a new directory name to signify a directory to hold the 

conflicting file. For example, PrivateDir.

6. Click the Next button.

The File Conflicts dialog box appears. This displays conflicts between 

files that are NOT listed in the Windows registry. You usually can move 

such files without causing problems.

The top list displays the conflicting files, including file name, version, 

date and time, size, and other identifying characteristics. You might 

need to scroll the list horizontally to see some of the information. 

However, you can resize and move the columns, and you can sort on 

any field by clicking the column heading. You also can resize the dialog 

box to see more of the file information.

7. Decide which file or files you want to move or use. Then select the file 

or files in the top list and take the appropriate action as described 

below. You can use SHIFT-click or CTRL-click to select multiple files. 

When you resolve a conflict for a file, the exclamation point to the left 

of the file name changes from red to white.

• Click the Move button to move the selected file to the private 

directory and tell the application to look for the file there. This 

button is not available if you chose the Do not move files isolation 

method in the Welcome dialog box.
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• Click the Latest button to use the most recent version of the selected 

file for the active installation. If one file has a newer version but 

another has a newer date/time, a Latest File Selection dialog box 

appears, where you choose whether to use the file with the newest 

modified date or the highest internal version number.

• Click the Fix Comp button to change the file’s component. This can 

fix the following issues:

• If the file is a KeyPath to one component but not another, make 

the file a KeyPath to its own component.

• If the file has extra non-advertising resources, move them to a 

new component.

• If the file’s shared .DLL counter is not set, set it.

If the component has more than one of these issues, a Fix Options 

dialog box appears, where you can select which actions to take.

• To apply a file in the top list to an application package in the bottom 

list, select the desired file in each list and click the Copy Down 

button. The file remains in its current location but will be used to 

install the application in the bottom list.

• To apply a file in the bottom list to the current application, select the 

desired file in each list and click the Copy Up button. The file remains 

in its current location but will be used to install the application in the 

top list.

• To undo changes made to a particular file, click the file, then click 

the top or bottom Revert button, depending on whether the file is in 

the top or bottom list. This resets the file to the state it was in when 

you imported the installation.

8. Click the Next button.

The File Conflicts in Registry dialog box appears. This displays conflicts 

between files that ARE listed in the Windows registry.

The top list displays the conflicting files, including file name, version, 

date and time, size, and other identifying characteristics. You might 

need to scroll the list horizontally to see some of the information. 

However, you can resize and move the columns, and you can sort on 

any field by clicking the column heading.
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9. Decide which file or files you want to move or use. Then select the file 

or files in the top list and take the appropriate action as described 

below. You can use SHIFT-click or CTRL-click to select multiple files. 

When you resolve a conflict for a file, the exclamation point to the left 

of the file name changes from red to white.

• Click the Move button to move the selected file to the private 

directory and tell the application to look for the file there. This 

button is not available if you chose the Do not move files isolation 

method in the Welcome dialog box.

Caution:

When conflicting files are listed in the registry, moving them to a 

private application directory can cause problems. ConflictManager updates 

the registry when a file is moved to a private application directory. This can 

cause other applications to follow the moved file and result in a further 

conflict.

• Click the Latest button to use the most recent version of the selected 

file for the active installation. If one file has a newer version but 

another has a newer date/time, a Latest File Selection dialog box 

appears, where you choose whether to use the file with the newest 

modified date or the highest internal version number.
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• To apply a file in the top list to an application package in the bottom 

list, select the desired file in each list and click the Copy Down 

button. The file remains in its current location but will be used to 

install the application in the bottom list.

• To apply a file in the bottom list to the current application, select the 

desired file in each list and click the Copy Up button. The file remains 

in its current location but will be used to install the application in the 

top list.

• Click the Details button to open a separate dialog box listing all the 

registry keys that contain the path to the selected file.

• To undo changes made to a particular file, click the file, then click 

the top or bottom Revert button, depending on whether the file is in 

the top or bottom list. This resets the file to the state it was in when 

you imported the installation.

10.When you have resolved all file conflicts, click the Finish button.

The Resolve wizard makes the changes you specified and then closes.

Resolving Registry Key Conflicts
The Resolve and Resolve with Rules commands resolve only file conflicts. 

To Resolve registry key value conflicts, you must use the Properties dialog 

box that is accessible from the Application Explorer.

Caution:

Resolve registry key conflicts only if you are the developer of the application 

and you have extensive knowledge of how Windows operates. Changing registry 

information incorrectly can damage the installation. Be especially careful when 

changing information in HKEY_CLASSES_ROOT, because incorrect changes there 

can damage the operating system.

To resolve registry conflicts:

1. Retrieve conflicts:

• If you want to retrieve conflicts for a group, click a group in the 

Groups pane (Enterprise Edition only).

• In the left pane of the Conflict List, select an application from the 

Application drop-down list.

• In the Package drop-down list, select the application package for 

which you want to display conflicts.

• In the Conflict Type drop-down list, select the type of conflicts you 

want to display, in this case, either All or Registry.
97



6: FINDING AND RESOLVING CONFLICTS
• Mark the Errors checkbox to list error conflicts.

• Click the Retrieve button to display conflicts.

2. In the right pane of the Conflict List, click the registry item for which 

you want to resolve conflicts.

3. In the right pane of the Application Explorer, double-click the registry 

key for which you want to resolve conflicts.

A Properties dialog box appears.

4. Click the Conflicts tab. This shows the registry keys that conflict and 

displays their values.
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5. Decide which value you want to use and write it down on paper exactly 

as it appears.

6. Click the Registry Key Settings tab.

7. In the Data Value field, enter the key value you recorded from the 

Conflicts tab. Be sure to type the value exactly.

8. Click OK to save the change and close the dialog box.

Now you can export, compile, and test the application.
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Exporting Applications After Resolving 
Conflicts

After you resolve all conflicts for an application, you can export the 

changes to the original WiseScript (.WSE) or Windows Installer file (.WSI 

or .MSI), which you then recompile. This produces an installation that does 

not conflict with other applications on your company’s systems. You can 

export the installation to a single computer or to a network share point. 

The export function requires an existing installation file to export to; it 

cannot create a new installation file.

ConflictManager contains two menu commands for exporting installations 

after you have located and resolved conflicts in them.

• Export. Writes an application’s database information to an installation 

file. When you export a WiseScript installation, you have the option to 

overwrite the existing installation or modify it with the changes made in 

ConflictManager. Exporting to a Windows Installer file (.MSI or .WSI) 

always overwrites the existing data. After you export an installation you 

must compile it in either the Windows Installer Editor or WiseScript 

Editor. See Exporting an Application on page 101.

• Export and Recompile. Exports all applications whose conflicts have 

been resolved. An option lets you recompile the applications 

automatically after exporting. This is useful when you resolve conflicts 

for multiple applications, especially when you use the Resolve with Rules 

command. That way, you don’t have to keep track of which applications 

you’ve changed, and you don’t have to recompile them individually. See 

Exporting and Recompiling Applications on page 103.

Note:

In order to export an application, the original installation and its associated 

files, as well as any new files you have added during conflict resolution, must have 

a valid source path.
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Exporting an Application
Use this command to export changes for a single application. The 

installation you plan to export to must already exist. When you export to a 

.WSE or .WSI file, you must compile the installation after exporting. You do 

not have to compile .MSI files.

To export an installation:

1. From the Application menu, select Export.

The Export Application dialog box appears.

2. In the Application Name field, select the application that you want to 

export.

3. In the Package Name field, select the package that you want to 

export.

4. In the Installation File field, specify the path and file name of the 

Windows Installer installation file (.WSI or .MSI) or WiseScript file 

(.WSE) to which you are exporting. This field defaults to the installation 

file that was originally imported into ConflictManager, the location of 

which is stored in the database. Normally, you should accept the 

default. If you are exporting a WiseScript, you can export to a different 

file.

If a file was imported from a WiseScript, you must export it as a 

WiseScript. If a file was imported from a Windows Installer file, you 

must export it as a Windows Installer file. 
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5. The Export Options section of the dialog is different depending on what 

the type of file is being exported.

• If you’re exporting to a WiseScript file (.WSE). select one of the 

following options:

• Overwrite existing installation. Mark this option to replace 

the entire installation with the information in the ConflictManager 

database.

• Merge changes with existing installation. Mark this option to 

add only the changed information to the existing installation.

• If you are exporting to a Windows Installer file (.WSI or .MSI), you 

don’t have a choice to overwrite or merge because the installation 

file you choose is always overwritten. If you have previously 

distributed this .MSI to users, the Small, Minor, and Major options in 

the Upgrade Type drop-down list (listed below) change your 

installation so that it contains the necessary changes to function as 

an application update. 

• None (Do not modify). Choose this if you have never 

distributed this .MSI to users. The only changes in the exported 

.MSI are the conflict resolution changes. 

• Small (Change PackageCode). Select this option if you want 

to ship this version of the application as a patch or reinstall. 

Small updates generally contain minimal updates such as 

changes to the contents of files. This option creates an .MSI that 

has conflict resolution changes plus a new package code, which 

will reinstall over the previous version to update it. If you want a 

patch, use the Patch Wizard to create a patch between the 

previous version .MSI and the .MSI you are exporting. 

• Minor (Change Version and PackageCode). Select this 

option if you want to ship this version of the application as a 

patch or reinstall. Minor updates generally contain changes such 

as new or removed features, files, or other items. This option 

creates an .MSI that has conflict resolution changes plus a new 

package code and version, which will reinstall over the previous 

version to update it. If you want a patch, use the Patch Wizard to 

create a patch between the previous version .MSI and the .MSI 

you are exporting. The only difference between Small and Minor 

is that a Minor update updates the version of the installed 

application.

• Major (Change ProductCode, Version and PackageCode). 

Select this option if you want to ship this version of the 

application as an upgrade. You usually ship an installation as an 

upgrade when it contains comprehensive changes. If you select 
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this option, an upgrade entry is created on the Upgrade page, 

and this update will upgrade previous versions. 

6. If you are exporting an .MSI, you can specify a transform file (.MST) in 

the Transform field. Do this when you do not want to change the 

original application installation. The changes you made to the 

installation in ConflictManager are saved in the transform file, which 

you can then apply to the original installation.

7. Click OK.

The installation file you specified is updated with the application 

information from the ConflictManager database.

8. Open the installation file in either Windows Installer Editor or 

WiseScript Editor as appropriate and compile it.

Exporting and Recompiling Applications
Use this command when you want to export changes for more than one 

application, or when you want to recompile one or more applications 

automatically after exporting. This process always overwrites the original 

installation files.

To export and recompile applications:

1. From the Application menu, select Export and Recompile.

The Export Changed Applications and Recompile dialog box appears. 

This lists all applications whose conflicts have been resolved since their 

information has changed in the database.
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2. Mark the checkboxes next the to applications you want to compile.

3. To compile the applications automatically after exporting them, mark 

the Compile the applications after export checkbox.

4. Click OK.

The applications you marked are exported to their original installation files. 

If you marked the Compile the applications after export option, they 

are then recompiled.
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Chapter 7

Running Conflict Reports

After detecting conflicts, you might want to review them in a different 

format than the on-screen display. ConflictManager provides conflict 

reports that you can generate and either read on the screen, print, or 

export to an application, file, or e-mail message.

In this section, learn:

• What reports are available.

• How to interpret the conflict level on the reports.

• How to use the report viewer.
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What Reports Are Available?

The Professional Edition of ConflictManager provides the following reports:

• File Conflict for a single application

• Registry Conflicts for a single application

The Enterprise Edition of ConflictManager also provides the following 

reports:

• File Information

• File Conflict, for a single application, for all conflicts sorted by file, or for 

all conflicts sorted by application or group

• Registry Conflicts, for a single application or for all applications in a 

group or in the database

These reports have been developed using Crystal Reports 8.0. The 

ConflictManager installation installs the Crystal Reports runtimes on your 

computer, so you don’t need the full version of Crystal Reports to run the 

ConflictManager reports. The ConflictManager reports are located in the 

ConflictManager\Reports directory under the Wise Package Studio 

directory, with the extension .RPT.

File Information Report
Use this report to view information about files of one or more file types. For 

each file, the report lists the file name, size, date/time, version, company, 

product, install location, and application.

Enterprise Edition only

This report is available in the Enterprise Edition only.

To generate this report:

1. From the Reports menu, select File Information.

2. In the Filename field in the File Report Selection dialog box, enter a 

wildcard to specify the files to include on the report. You can enter *.* 

to report on all files, or use a file extension such as *.DLL to report only 

on files of a particular type.

3. Click OK.

The report opens in the report viewer window. For information about the 

report viewer, see Using the Report Viewer on page 112.
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File Conflict Reports
Use these reports to view file conflicts in varying formats. ConflictManager 

provides three file conflict reports:

• File Conflict Report for a single application. For a selected 

application, this report lists each conflicting file and its location, version, 

size, company, and product, as well as the files in other applications that 

conflict with it. The report is sorted in file order.

• File Conflict Detail for all conflicts sorted by file. For a selected 

group of applications or for all applications, this report lists each 

conflicting file and its version, size, date/time, company, and product. 

The report is sorted in file order. This report is available in the Enterprise 

Edition only.

• File Conflict Report for all conflicts sorted by application. For a 

selected group of applications or for all applications, this report lists 

each conflicting file and its location, version, size, company, and 

product, as well as the files in other applications that conflict with it. The 

report is sorted in application order. This report is available in the 

Enterprise Edition only.

The File Conflict report for a single application and for all conflicts sorted by 

application contain a conflict level field. For information on what the conflict 

level represents, see Interpreting the Conflict Level on page 110.

To generate a file conflict report for a single application:

1. From the Reports menu, select File Conflicts > Conflicts for One 

Application Only.

The Report Application Selection dialog box appears.

2. In the Application Name field, select the application for which you 

want to run the report.

3. In the Enterprise Edition, you must also select the Group of 

applications for which you want to run the report.

4. Click OK.

The report opens in the report viewer window.

To generate a file conflict report for all applications, sorted by file:

1. From the Reports menu, select File Conflicts > All Conflicts Sorted by 

File.

2. In the Report Application Selection dialog box, choose the Group for 

which you want to run the report.

3. Click OK.

The report opens in the report viewer window.
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To generate a file conflict report for all applications, sorted by 

application:

1. From the Reports menu, select File Conflicts > All Conflicts Sorted by 

Application.

2. In the Report Application Selection dialog box, choose the Group for 

which you want to run the report.

3. Click OK.

The report opens in the report viewer window.

For information about the report viewer, see Using the Report Viewer on 

page 112.

Registry Conflicts Application Report
Use this report to view registry conflicts for a single application. If you are 

using the Enterprise Edition, you can also run this report for all applications 

in a group or in the database. The report lists the key, name, and value of 

each conflicting registry entry along with a table that lists the conflicting 

registry entries in other applications.

The Registry Conflicts Application report contains a conflict level field. For 

information on what the conflict level represents, see Interpreting the 

Conflict Level on page 110.

To generate this report for a single application:

1. From the Reports menu, select Registry Conflicts > Conflicts for One 

Application Only.

The Report Application Selection dialog box appears.

2. In the Application Name field, select the application for which you 

want to run the report.

3. In the Enterprise Edition, you must also select the Group of 

applications for which you want to run the report.

4. Click OK.

The report opens in the report viewer window. For information about the 

report viewer, see Using the Report Viewer on page 112.

To generate this report for a group of applications:

1. From the Reports menu, select Registry Conflicts > All Conflicts.

2. In the Report Application Selection dialog box, choose the Group for 

which you want to run the report.

3. Click OK.
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WHAT REPORTS ARE AVAILABLE?
The report opens in the report viewer window. For information about the 

report viewer, see Using the Report Viewer on page 112.
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Interpreting the Conflict Level

Some ConflictManager reports display a conflict level for files that have 

conflicts. The conflict level is a numeric representation of the different 

conflict classifications: error, warning, and informational.

The following table shows the kind of conflict represented by each conflict 

level.

Conflict 

Level
Conflict Classification

1 Informational, not a true conflict and not likely to cause a 

problem

2 Warning, a possible conflict

4 File error, deserves attention

8 Component error, deserves attention
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INTERPRETING THE CONFLICT LEVEL
A file can have a combination of conflicts with different applications; in that 

case, its conflict level might be one of the following values:

Conflict 

Level
Conflict Classification

3 1 + 2 (informational + warning)

5 4 + 1 (file error + informational)

6 4 + 2 (file error + warning)

9 1 + 8 (component error + informational)

10 8 + 2 (component error + warning)

12 8 + 4 (file error + component error)
111



7: RUNNING CONFLICT REPORTS
Using the Report Viewer

After you generate a report, it displays in a report viewer window. You can 

read the report on the screen, print it, or export it to an application, file, or 

e-mail message. To close the report viewer and return to ConflictManager, 

click the Close button.

This section describes how to use the report viewer.

Navigating Through Reports on the Screen
To review a ConflictManager report on the screen, you can use the vertical 

and horizontal scroll bars to scroll to the left, right, top, and bottom of the 

current page. To move from page to page, use the toolbar or the right-click 

menu. You cannot scroll from one report page to another using the scroll 

bars.

 Click the First Page tool to go to the first page of the report. You can 

also right-click and select First Page.

 Click the Previous Page tool to go to the page that precedes the 

current page. You can also right-click and select Previous Page.
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 Click the Next Page tool to go to the page that follows the current 

page. You can also right-click and select Next Page.

 Click the Last Page tool to go to the last page of the report. You can 

also right-click and select Last Page.

Printing a Report
If you want a hard copy of a ConflictManager report, you can print it on 

your default printer.

To print a report:

1. From the right-click menu in the report viewer, select Print.

A Print dialog box appears.

2. Define the page range and the number of copies to print, and choose 

whether to collate the copies.

3. Click OK.

The report is printed on your default printer.

Exporting a Report
The report viewer lets you export a ConflictManager report in a variety of 

formats. You can export a report directly to an application, such as 

Microsoft Excel, or to a file, or to an e-mail message.

To export a report:

1. From the right-click menu in the report viewer, select Export.

An Export dialog box appears.

2. From the Format drop-down list, select the data format to which you 

want to export.

3. In the Destination drop-down list, select an option to determine where 

to export the report.

• Application. Open the application associated with the selected data 

format, then open the report within that application.

• Disk file. Export the report to a file.

• Microsoft Mail (MAPI). Send the report as e-mail.

4. Click OK.

5. Additional dialog boxes might appear, depending on the data format 

selected. For example, if you select Character-separated values in 
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the Format field, additional dialog boxes let you specify the character 

separator and delimiter as well as the number and date formats.

6. Depending on the destination selected, one of the following dialog 

boxes appears:

• If the destination is Application, the application associated with the 

selected data format launches, then opens the report within the 

application. This can take a few moments if the report is large. For 

example, if you choose Excel as the format, the report opens in 

Microsoft Excel.

If your computer does not have an application associated with the 

selected data type, an Open With dialog box appears, where you can 

specify the program to use to open the exported report.

• If the destination is Disk file, a Choose Export File dialog box 

appears, where you specify the name and directory location of the 

exported report file.

• If the destination is Microsoft Mail (MAPI), a Send Mail dialog box 

appears, where you enter the recipient’s e-mail address. Additional 

fields let you enter a subject line and message. Click the Send 

button to send the message. The report is either included as an 

attachment or as text, depending on the data format.

Copying and Searching for Data in the Report
The report viewer lets you copy data from a single cell of a ConflictManager 

report so you can paste it into a document. You also can search for a 

specific text string within the report.

To copy data from a report:

1. In the report viewer, right-click in the cell that contains the data you 

want to copy.

2. From the right-click menu, select Copy.

3. The data in the selected cell is copied to the Windows Clipboard.

Note:

This doesn’t work in cells that are designated as “Text.” Text cells are a 

combination of several database fields.

To search for text in a report:

1. From the right-click menu in the report viewer, select Search.

A Search dialog box appears.
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2. In the Find What field, enter the text string to find.

3. Click the Find Next button to begin the search.

If the text is in the report, the first occurrence of it is outlined in red in 

the area of the report where it was found.

4. To find other occurrences of the same text string, click the Find Next 

button again.
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